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Release Notes for  
IVS-Professional 

Version 4.6 – Released 03/26/2024 
Please note that these release notes are not entirely complete. New feature might have been added 

and bugs might have been fixed that are not included in these notes. 

New features 

 The properties dialog has been updated. It now supports setting the properties of multiple selected 

objects at once, even if the objects are of different types. If a property is the same for all selected 

objects, that property will be filled in in the properties dialog box. If a property differs across the 

selected objects, that property will not be filled in. As long as you do not modify a property, all 

selected objects will keep their original setting for that property. If you do modify a property, that 

property will be set for all selected objects. If you click the OK button, any modified properties will 

first be applied to all selected objects, and then the dialog box will be closed. If you click the Apply 

button, which will only be enabled if you modified any property, the modified properties will be 

applied to all selected objects. If you click the Cancel button, the dialog box will be closed without 

applying any modified properties. If you press the  key, the Cancel button changes into a Reset 

button. Clicking the Reset button will reset all modified properties back to the state they had when 

either you last clicked the Apply button, or when the properties dialog box was opened. 

 The same is true for the text edit dialog. You can now select multiple text objects (either question, 

answer, text or field) and edit the text formatting for all selected objects at once. If the selected 

objects contains different texts, you can only edit the formatting and not change the text itself. Only 

if the selected objects contain the exact same text, you can also change the text itself. The dialog 

also has an Apply button to apply the changes without closing the dialog. And if you press the  

key, the Cancel button changes into a Reset button, to reset the modifications back to the state they 

had when either you last clicked the Apply button, or when the dialog box was opened. To make all 

this possible, the order for creating new objects has changed a little. When you insert a new question, 

answer or text, the object is first inserted into the slide and then you can enter the text for it. If you 

click Cancel, the object will be removed again. However, if you clicked Apply once and then click 

Cancel, the object will stay. 

 A Lite Base Station can now also be shared on a network. This requires an additional server applica-

tion, that is included in this release. The Network Base Station Locator tool is now also able to detect 

these shared Lite Base Stations, and can link them to a serial port. A new communication plugin is 

included that can be used to communicate with these Network Lite Base Stations. This plugin, nor 

the server application, are installed by default. 
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 The Configure IVS-Online Connection wizard has an extra option for online scripts that use identified 

voting. You can now allow a user to act as a proxy for another user. After logging in with his own 

credentials, the user can also log in for at most one other user, and can then vote on both his own 

and the other user’s behalf. 

Minor changes 

 The Preferences dialog box did not respond to the Escape key if you wanted to cancel the dialog. 

 A new option has been added to the Edit tab of the Preferences dialog. If you enable the ‘Only select 

fully contained controls’ option (which is the default), then, when you draw a selection rectangle 

around objects, only those object that are fully contained within the selection rectangle are selected. 

If you disable this option, then all objects that are only partly covered by the selection rectangle are 

selected. You can always temporarily invert this behavior by pressing the  key while drawing 

the selection rectangle. 

 When duplicating Participant or Score fields, the participant index is automatically increased for the 

duplicate. This means that when you duplicate a Participant field that refers to participant 1, the 

duplicate will automatically refer to participant 2. And also when you duplicate a Score field that 

refers to participant 1, the duplicate will refer to participant 2. Only when the original Score field 

refers to participant 0, the duplicate will still refer to participant 0, but now the group index will be 

increased. If you don’t want the fields to be updated, you can use the key combination 

 +  +  +  instead. Or you can permanently disable updating fields on the Edit tab of the 

Preferences dialog. If you permanently disable it, you can still use the key combination 

 +  +  +  to temporarily enable updating fields again. 

 When the Show Field Settings option is enabled, each field displays its settings as they are used 

internally by the field. For a Score field, the participant’s index starts at index 1, where index 0 has 

the special meaning of ‘all participants’. For a Participant field, however, the participant’s index 

starts at 0, where 0 means participant 1, and 1 means participant 2. This could be rather confusing, 

so the Participant field now displays index 1 for participant 1, just like the Score field does. 

 The info dialog, that is displayed when initializing keypads, loading keypads from a list or testing the 

network, has been updated. It is a little bit bigger, has a header bar at the top that better indicates 

what the Base Station is currently doing, and also indicates what channel the Base Station is currently 

operating on. 

 Support for the RF-I Base Station and CC25 has been removed. 

 Support for the RF-I keypad has been removed from the RF-II Base Station. If you use an RF-II Base 

Station, you can now only use RF-II keypads. The communication wizard therefore no longer asks 

you which keypad type you want to initialize. 

Bug fixes 

 If you double-clicked a text object (either question, answer or text) with a text containing different 

font sizes, the font size would be reset to the font size of the first character. 

 A minor change in the previous version, where the autostore keypad list file was no longer stored as 

the last keypad list file used, turned out to have a negative side-effect. If you loaded a keypad list, 
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then initialized some extra keypads without saving the keypad list yourself, and then closed and 

restarted the application, you were offered to load the last used keypad list. This is intended behav-

ior, however, the last used list that was loaded, was the original keypad list, and not the autostore 

file containing the extra initialized keypads. Therefore, this change is partly reverted, so that the 

autostore keypad list can be loaded again, but it will not be offered as a suggestion when you man-

ually load or save a keypad list. 

 If you tried to insert an image and selected a file that had the correct file name, but the file itself was 

empty, the application would be terminated without any warning. 

 When quickly inserting objects, for example a range of answers without any text, the entire slide 

could temporarily disappear, leaving only a gray window. 

 When a script was opened that uses a custom screen resolution, the Preferences dialog did show 

that a custom resolution was set, and also did show the correct resolution, but the edit boxes for the 

resolution were disabled. 

 Under some circumstances, the application could throw an error when it was closed with a still active 

connection to IVS-Online. 

Version 4.5.9 – Released 10/09/2019 
Minor changes 

 The font combobox, used in the text editing window, filled in the font list twice, which took an 

unnecessarily long time, especially if you had a large amount of fonts installed. 

 That same font combobox now has a little delay built in, so that when you start typing, not every 

single font that is selected by the auto-complete function, is actually applied to the selected text. 

 That is also true for the font size combobox. Besides, the font size combobox no longer accepts 

invalid characters, it also allows you to select sizes if multiple fonts are selected, and the drop down 

list shows more sizes, so that you don’t have to scroll the list. 

 If you close a script while the voting is still open, a warning is displayed, asking you if you are sure 

to also close the voting. 

 If a presentation is started and is displayed on the same monitor as the script, it will no longer appear 

in the Windows taskbar and in the Alt-Tab menu. Also, clicking the taskbar button will now bring up 

the presentation screen rather than the script. This is to prevent you from accidentally switching to 

the script window, where most of the options are unavailable as long as the presentation is running. 

 Updated IVS-Card Link and IVS-Participant Registration to also support the new HID Global/Omnikey 

CardMan 3121. Although it has the same model number, it is internally known as a CardMan 3031 

and requires new drivers. These drivers are now included in and pre-installed by the installer. 

 If you load a keypad list and then start initializing extra keypads, after stopping initialization, the 

keypad list is automatically stored. This autostore file was also set as the last used keypad list. If you 

then wanted to store the keypad list, you were offered to store it as the autostore file in a temporary 

folder, rather than as the keypad list you loaded before. The autostore file is now no longer set as 

the last used keypad list, unless you load it yourself. 
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 When initializing keypads for more than one Base Station, the message box asking to start the ini-

tialization now also mentions the channel the Base Station operates on, and asks you to initialize or 

skip this Base Station. 

 When opening the voting without having started a session, a message box appears that now allows 

you to immediately start a session, instead of just canceling the voting. 

 When calculating the total voting time for a participant, the voting time for a question that resulted 

in a score of 0 points, is no longer added to the total. This way, when two participants end up with 

the same score, the time it took them to give a wrong answer, is no longer taken into consideration. 

This gives a fairer end result when determining the position of participants with the same score. 

 A new option ‘This answer selects all the answers above’ was added to the advanced tab of an 

answer’s properties. It can only be enabled for answer number 3 and above, and when the question 

allows at least two votes to be given. When enabled, if a participant selects this answer, all answers 

above this answer will be selected instead. For instance, if this option is enabled for answer 5, when 

a participant selects answer 5, then answer 1, 2, 3 and 4 will automatically be selected instead, 

assuming that the question allows four answers to be given. Otherwise as many answers as the 

question allows are selected instead. 

 The Icon Handler Shell Extension now uses Direct2D instead of GDI+. This fixes the occasional Win-

dows Explorer crashes. 

 The startup dialog now stores a file’s last used time in the registry, instead of relying on the actual 

file’s last access time. Because the startup dialog actually accesses the file to retrieve its preview 

image, the last used time would always be the same for all files, namely the last time the startup 

dialog was displayed. 

 In the preferences dialog, the maximum value for the duplicate placement and the grid size now 

depends on the selected screen size, rather than being a fixed value. Also, both now have a link 

button between the horizontal and vertical size box, which, when clicked down, keeps the horizontal 

and vertical value the same. 

 In the Configure IVS-Online Connection wizard, it was not possible create a new user without filling 

in a password and not providing an email address. This was done because it would be impossible 

for the user to know his automatically generated password if this wasn’t sent to him in an email. 

However, it is also possible to retrieve the user’s password by exporting the internet participants. 

Therefore, it’s now no longer required to fill in an email address if no password is given. 

 The Configure IVS-Online Connection wizard had no texts filled in by default for the welcome texts. 

If the texts are left empty, the server automatically creates two defaults texts. To make it clear what 

the server will do, the default texts are now prefilled as placeholder texts. If you fill in your own 

texts, then these will be used by the server. If you don’t, the placeholder texts will be used. 

 The behavior of the Result field has changed, when it needs to display a majority of the number of 

voters. The majority now also takes into account the voting weight of the voters, where in previous 

versions of the software it would ignore the voting weight. If you want the old behavior, you also 

have to enable the ‘Ignore voting weight’ option. Also, if the option ‘Last answer does not belong to 

total’ is enabled, the result of the last answer is subtracted from the number of voters. It is assumed 

that the last answer can only be voted for once. 
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 A work-around was added for Windows 8.1 and Windows 10 not remembering the previous window 

size. If you maximized the main application window, then closed and restarted the application, the 

main window would be shown maximized. If you then restored it to its previous size, the main win-

dow would be as small as 320 x 240 pixels, instead of the size that was set before the window was 

maximized. This only occurred on Windows 8.1 and Windows 10. A work-around was added to make 

Windows remember the correct window size before maximizing it. 

 When opening a text file script, that was saved using UTF-8 encoding without a Byte Order Marker 

(as of Windows 10 version 1903, this is the default for Notepad), IVS-Professional assumed that the 

file used Ansi encoding, which could lead to wrong characters appearing, especially when accented 

characters were used. When opening a text file without a BOM, IVS-Professional now tries to guess 

the encoding by first examining the entire file. 

Bug fixes 

 When right-clicking on a script file, the context menu offered to open the script with IVS-Basic, but 

the option was disabled. This was caused by the version information in the Context Menu Shell 

Handler, that wasn’t updated to the correct version. The Shell Handler now takes the information 

directly from the Windows registry, so that in the future, an update to the version information isn’t 

needed anymore. 

 Due to a change in the IVS-Risk Analysis application title bar, IVS-Professional was unable to find 

the application window and therefore couldn’t send any messages about updated vote results to 

IVS-Risk Analysis. This resulted in IVS-Risk Analysis no longer automatically updating the heat map 

after voting in IVS-Professional. 

 If IVS-Professional was closed while the voting was still open, the voting would be cancelled instead 

of closed normally. This could result in a loss of results. 

 If one or more questions, used in a scoreboard, contained more than one correct answer, and users 

were allowed to vote multiple times on this question, and a user chose both correct answers, this 

one user was added to the scoreboard twice, once with the score for the first correct answer, and 

once with the score for the second correct answer. This could mess up the entire scoreboard, poten-

tially displaying the same user twice with different scores. 

 If, when opening a script, you switched to another application while the script was still opening, an 

error message “Could not register tab” was displayed, and the script would not be opened, but 

instead an orange window was displayed. 

 When run from a Terminal Services environment, opening a script would show an error message 

“Could not register taskbar”, and the script would not be opened, but instead an orange window 

was displayed. 

 When opening multiple scripts, the script windows are cascaded. When a window no longer fits on 

screen, it will be displayed at the top-left corner of the screen. When this happened, the window also 

got resized, so that it still wouldn’t fit entirely on screen. 

 When retrieving identified results from an online questionnaire, the participants list was stored in 

the newly created session, along with the results. However, the participants list was not loaded into 

memory, although the results were loaded and displayed. This could lead to the wrong results being 
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displayed, if the session used voting weights, or the wrong results being exported. This was only the 

case immediately after retrieving the results. If the newly created session was later imported again, 

the results were displayed and exported correctly. 

 When, after switching on an RF-II Base Station, a keypad list with a large amount of keypads was 

loaded and then the network was tested, the Base Station could become unresponsive and ultimately 

go offline. 

 If a session was imported into a script using online voting, which was set to Anyone can vote after 

registration, the participants list was not updated anymore when new participants registered for 

voting. Even though the new participants could vote, their vote was counted and also stored, their 

vote was not shown in the overall results, because they were not in the participants list. Only after 

manually editing the participants list and importing the session again, their votes were shown in the 

overall results. 

 When calculating the total score a participant or group of participants could get when voting for all 

correct answers, participants that were disabled, were still taken into account. Even though they 

couldn’t vote, their score was still added to the maximum achievable score. This resulted in a group 

never being able to achieve a score of 100%. 

 The context menu for objects showed the ‘Order’ option in English, regardless of which language 

pack you had installed. 

 When inserting a set of answers from a template, the same set of answers was always inserted, 

regardless of which option you chose. 

 If you opened a script, made some changes and then reopened the same script, you were asked if 

you wanted to revert to the last saved version. However, if you clicked Yes, IVS-Professional would 

be closed entirely, and, if you had initialized a Base Station, it would throw some Access Violations. 

 When resizing an object while the ‘Snap to objects’ option was enabled, the object would not 

properly snap to the slide’s bottom boundary or vertical center, because the slide’s width was acci-

dentally taken as the slide’s height. 

 When resizing an image or multimedia object by moving either the top center or bottom center 

handle, the object could not be made smaller than roughly half its previous size. 

 In the Configure IVS-Online Connection wizard, it was possible to add a new user without providing 

a user name, if only an email address was given. In this case, the email address should have been 

used as the user name, but it wasn’t. The wizard would then fail to create the new user. 

 If, when starting a new session with identified voting, the editbox containing the participant list 

filename was cleared, an ‘Invalid characters in file name’ error would occur. 

 Some menu items have a secondary keyboard shortcut, which can be used to execute the action, in 

addition to the primary shortcut, even though the secondary shortcut is not visible in the menu itself. 

For example, the Go to slide menu item has a shortcut of  +   +  and a secondary shortcut 

of . Some of the secondary shortcuts, like , didn’t work if the computer’s keyboard layout was set 

to a layout where that key was named differently. 

 If the background of a result chart was set up to use an image, a ‘Cannot assign a TAdvancedPicture 

to a TBitmap’ error message was displayed each time you clicked anywhere on the slide, making it 

impossible to continue working with your script. 
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 In the German version, some of the color picker buttons in the properties dialog had a Dutch text as 

the last option in the color popup, rather than a German text. 

 When executing a lengthy operation, the hourglass cursor was not shown when a script was opened. 

 When printing a script to images, the field settings, when enabled, were also printed, though they 

were only supposed to be shown in the edit screen. 

 When printing a script, you could use the print settings dialog to select that only the current page 

should be printed. Even though the ‘From slide’ and ‘To slide’ comboboxes were set to the correct 

slide, clicking the OK button would still print the entire script, rather than only the selected slide. 

Version 4.5.8 – Released 11/30/2018 
New features 

 The Communication Wizard has a new option to automatically detect any connected USB clusters. 

This option is much faster than the option to automatically search for all clusters, because it will get 

its information from the Windows Device Manager, and therefore know immediately which device 

is attached to the computer and connected to which serial port. 

 You can now double-click an IVS communication file, which will be opened in IVS-Professional. IVS-

Professional will then find out which Base Stations are connected to the computer, automatically set 

up and initialize the Base Stations, analyze the communication file to see which channels are used, 

set the connected Base Stations to those channels and then load the keypads from the communica-

tion file. This allows you to set up the entire system by only opening the communication file. 

Minor changes 

 The question and answer number no longer push the question or answer text to the right if the 

number text font is bold or italics. Instead, the number text grows to the left. 

 A warning message was added when you try to close the script that is currently being used for the 

presentation screen. In previous versions, the presentation screen was closed without a warning. As 

of this version, a warning message is displayed, asking you if you are sure to also stop the presenta-

tion. 

 When the result chart displays its results in percentages, the number of digits in the percentages will 

now always be exactly the number you set in the chart’s properties. In previous versions, any trailing 

zeroes would not be displayed. If, for instance, the result was exactly 12.5%, it would always be 

displayed as 12.5%, even if you’d set the number of digits to four. It will now be displayed as 

12.5000%. 

 The mean value and the standard deviation, displayed at the bottom of the result chart, now follow 

the number of digits set in the chart’s properties. In previous versions, they would always display 

two digits. 

 If you save a template and call it either ‘normal’ or ‘widescreen’, then these will replace the default 

normal and widescreen templates. When starting the application, these user-defined templates will 

show up as the first two templates in the template list. 
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 If you have a script with identified questions and are connected to IVS-Online, using a semi-identified 

group, then you are not required to provide a participants list when starting a new session. You can 

leave the participants list field empty, in which case a new participants list will be created automat-

ically and will be filled with the users that log in to your IVS-Online script. 

 The current script’s zoom level is stored when you close the application and used again the next time 

you open the application. 

Bug fixes 

 The ‘No active session’ warning in the bottom right of the presentation screen was supposed to be 

displayed when no session was started while a Base Station was stand by. This warning was not 

always updated correctly, so that is could be displayed even though you had started a session, or 

wasn’t displayed after initializing a Base Station without starting a session. 

 When printing a hand-out, the dialog box, that allows you to select the number of slides per page, 

could under some circumstances be displayed behind the main window. Because the main window 

becomes inactive until you have made a choice in the dialog box, this could give you the impression 

that the entire application had become unresponsive. 

 If the Result field was set to display its result relative to the number of participants, it didn’t take 

into account any disabled or deactivated users in case of an identified voting. 

 If, after opening a script, you immediately started working in another application, a ‘Could not reg-

ister tab’ error might be displayed, and might even appear invisibly behind the application’s main 

window. 

 In the text editor for entering or modifying the question and answer text, if you tried to select a font 

by typing its name in the font combobox, and the font could not be applied, the previous font name 

would be filled in in the font combobox, erasing the part that you already typed. 

 Aligning answers to the bars in the result chart didn’t work if the chart wasn’t linked to the question 

on the current slide. 

 In the IVS-Online Connection Wizard, if you switched from an identified group (only a select group 

of participants can vote) to a semi-identified group (anyone can vote after registration) and the iden-

tified group was an anonymized group, the semi-identified group would also stay anonymized, which 

made it impossible to start a session with identified questions, because the remote script was anon-

ymous. 

 If no Base Stations were active, the status bar didn’t show the network status for the current question 

anymore. 

 If the timebar was set to play a sound clip, and that sound clip was very short (less than half a 

second), the sound clip wasn’t audible, and going to the next slide took about 6 seconds. The latter 

has been fixed, but note that the timebar (or the multimedia object) is still not able to play sound 

clips that are very short. 

 Deleting an object, then undoing ( + ) that delete operation, and then redoing ( +  + ) 

the delete operation, would not delete the actual object again, but would instead delete an object 

from the last slide in the script, or throw an error if the last slide didn’t contain enough objects. 
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 If the location where the script is stored wasn’t writable for the currently logged in user, starting a 

session would display the rather cryptic message ‘List index out of bounds’, instead of the message 

that the session could not be started. 

 If the timebar was set to open the voting and close the voting, it would not start running after 

opening the voting, because the close voting timer was accidentally skipped. 

 If a multimedia object was set to play an audio file and set to automatically start once the slide was 

displayed, it wouldn’t start to play the audio file, because the play command was issued before the 

multimedia object was actually ready to start playing a file. 

 If you chose to not show the startup dialog for selecting an existing script or creating a new one, the 

application’s main window would stay hidden, making it impossible to use the software. 

Version 4.5.7 – Released 09/25/2018 
New features 

 The user interface was changed from a Multiple Document Interface to a Single Document Interface. 

This means that script windows are no longer part of single parent window, but are separate win-

dows. Each script window has its own menu and toolbars. If you close the last script window, the 

application will exit. If you close the last script window using the File > Close menu option, the 

application will not exit, but show an empty main window instead. 

 The Configure IVS-Online Connection Wizard now also allows you to set up a message queue, that 

can be used by your remote voters to send messages to the moderator. The last page of the wizard 

will give you two extra links, one for the moderator, who has to approve the messages, and one for 

a message wall, where the approved messages will be displayed. 

 The Configure IVS-Online Connection Wizard now displays a summary page at the end, just before 

any changes will be applied. This will give you the opportunity to review the settings that will be 

applied and make any changes when necessary, before they are actually applied. 

 The Configure IVS-Online Connection Wizard has an option to create a real-time script (which has 

been the default up until now), or an online questionnaire. In case of an online questionnaire, you 

don’t have to use IVS-Professional to open and close the voting. Your users can answer the questions 

whenever they like, as long as the script is available. In the end you can retrieve the results using 

the Connection > Retrieve Online Questionnaire Results option. This will automatically cre-

ate and open a new session containing the online questionnaire results. 

 The Configure IVS-Online Connection Wizard can now create an anonymized user group. When add-

ing users to this group, you only have to provide an email address. A user name and password will 

automatically be created and sent to the user. If you run the wizard again, you will only see random-

ized user names in a random order. You cannot delete a single user (as you wouldn’t have a clue 

which user that would be), but you can delete all users at the same time. You can add extra users, 

but this will randomize the user names and order once again. 

 The Configure IVS-Online Connection Wizard has a new option on the invite page, that lets you invite 

only those users that were added during this run of the wizard. Users that were already there, will 

not be invited again. 
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 The multimedia object and the timebar object now both use the Windows Media Foundation to play 

movie and sound clips, instead of DirectShow and DirectSound. On Windows 8.1 and above, the 

Enhanced Video Renderer will be used to display the video on screen. On Windows 7 and 8, the 

Video Mixing Renderer 9 will be used instead, because of a bug in the EVR on these systems, which 

would paint the whole slide black when playing a video file. 

 To select multiple objects, you can now both Ctrl-click and Shift-click on the objects. Ctrl-click can 

also be used to click through an object. If one single object is selected, Ctrl-click on the object to 

select the first underlying object. Ctrl-click again to select the next underlying object (if any). Use 

Shift-click to deselect the selected object. 

 To select multiple objects, you can draw a selection rectangle around the object. Only objects fully 

contained within the selection rectangle are selected. You can now also Shift-click to draw a selection 

rectangle. In that case all objects that are partly or fully within the selection rectangle are selected. 

If you also keep the Ctrl-key down, the current selection isn’t cleared, so that you can add to the 

already selected objects. 

 It is now possible to resize multiple objects. Use the resize handles of one of the objects to resize 

that object. All other selected objects will be resized as well, using the same scaling percentage as 

the object being resized. 

 The new Snap to Objects option allows you to easily align objects. When enabled, objects being 

moved will snap to the sides or centers of non-selected objects. If multiple objects are selected, the 

object you click on to start the move operation, will be the object snapping to other objects. Snapping 

occurs for the left side, center and right side of the selected object, and either of those will snap to 

the left side, center or right side of any non-selected object. Snap to Objects can be enabled through 

the View > Snap to Objects menu item. When enabled, it can temporarily be disabled by pressing 

the Alt key while moving an object. 

 When you are moving an object, and keep the Ctrl-key pressed when you release the mouse button, 

the original object(s) will be duplicated instead of being moved. 

 The new menu option Insert > Quick Insert Answers lets you quickly insert a series of answers. 

You only have to enter (or copy/paste) the answers’ texts into a text box. Each line in the text box 

will be considered a single answer. (Note that if an answer’s text is too long, it will wrap to the next 

line. This is still considered a single line.) Empty lines are automatically skipped. 

 In the advanced properties for a question, a new option ‘Default answer’ was added. This option is 

only available for a reference question. With this default answer, you can set an answer for partici-

pants not answering the reference question. Participants not voting would normally not belong to 

any category in a reference question, and would therefore not be counted in a question that is 

crossed with this reference question. With the default answer, you can still assign them to a category 

if they don’t vote. 

 A new menu option View > Show field settings lets you easily view the settings of all fields on 

a slide. When enabled, in the top left corner of the field, a comma separated list of the field type and 

the settings for that field are displayed. 
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 In the properties of the question object and the answer object, you can now set a custom color for 

the question and answer number. This custom color can also be set in the template, so that you can 

apply it to all questions and answers at the same time. 

 Reintroduced support for GIF images. Due to incompatibility reasons, GIF support was removed in 

version 4.5.3. It came back in version 4.5.4, but only for non-transparent, non-animated GIF images, 

and disappeared again in version 4.5.6. GIF images are now fully supported with only one restriction: 

you cannot place more than one animated GIF image on a single slide. You can, however, place 

multiple non-animated GIF images on a single slide. There will be a warning when you try to add an 

animated GIF while there already is an animated GIF on the current slide. Also note that an animated 

transparent GIF image might display some odd colors in the transparent parts while animating. This 

is caused by the restricted color set for a GIF image. 

Minor changes 

 When changing the order of an object (or multiple objects), the object stays selected, so that you can 

easily repeat the order change (for example when bringing an object closer to the front). 

 If you save a script under a different name, any open session was automatically closed. This is to 

prevent the results meant for the new script from being saved in the old location. This behavior was 

changed, so that a session is now only closed when it can actually store results. Example results, for 

instance, cannot store results, so there is no need to close the session when example results are 

imported, because they do not depend on the script’s location. 

 In the start-up screen, where you select recently opened scripts, if you hover the mouse over an item 

in the list, the script’s filename is shown in an info tip. 

 The zoom level combobox in the top toolbar has been replaced by a toolbar button, including a plus 

and minus button and a fit to window button. You can click the plus and minus button to increase 

or decrease the zoom level in 10% steps. Click the fit to window button to set the zoom level to 

automatically zoom so that the slide fits within the entire window. You can also click the zoom level 

button to show a dialog box that allows you to set a specific zoom level. The View menu also has 

four new options to Zoom In ( +  or  + NUM+), Zoom Out ( +  or  + NUM-), Fit to Win-

dow ( +  or  + NUM0) or Zoom to 100% ( + NUM1). 

 The Advanced Typography options are no longer enabled by default for text objects (question, an-

swer, text and field). These advanced options caused the word break routine to break a line right 

after an opening parenthesis, which could leave the opening parenthesis on one line, and the text 

between the parentheses along with the closing parenthesis on the next line. According to the Mi-

crosoft documentation, the advanced typography options are automatically enabled when needed, 

so there shouldn’t be any need to enable them by default. 

 The Configure IVS-Online Connection Wizard has a link on the credentials page, which you can click 

in case you forgot your password. 

 The Connection > Copy Internet Script Link to Clipboard option has been replaced with 

Connection > Show Internet Script Link. Instead of simply copying the link to the clipboard, 

this option now displays a window containing the link in text and as a QR code. Clicking the link will 

open it in your browser. There are also two buttons to copy the link or the QR code to the clipboard. 
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The new Show Moderator Link and Show Message Wall Link will do the same for the mes-

sage wall page and the moderator page respectively. However, the link shown is a shorter version 

of the actual link. If you click on the link, copy the link or use the QR code, the actual link will be 

used, which takes you directly to the page. If you type in the shorter version, you first have to enter 

your credentials before being taking to the requested page. 

 The quality of the multimedia object’s first frame image has been improved. 

 When printing slides to an image format, the images now have the same dimensions as the script, 

instead of always being 1024 pixels wide. 

 The View > Show grid option shows a slightly altered grid, as the grid no longer starts from the 

top left of the slide, but instead starts from the center of the slide. The grid now also displays a 

horizontal and vertical center line, which indicate the exact center of the slide. 

 When the View > Snap to grid option is enabled, the objects not only snap to the grid when 

moved around, but they also snap to the grid when resized. You can temporarily disable the Snap to 

grid option by keeping the Alt key depressed. 

 If you have an active Base Station connected, it is not possible to start a presentation without also 

starting a session. However, it is possible to stop the session while the presentation is still running. 

A warning message will now be displayed in the lower right corner of the presentation screen, re-

minding you of the fact that no session was started and hence no results will be saved or displayed. 

 Upgraded GraphicEx to a newer version. GraphicEx controls the loading and decoding of image files 

in various different formats. Because of this upgrade, TIFF and PSD images, stored in various formats, 

can now also be loaded. 

Bug fixes 

 If the laptop’s primary monitor was set to a different DPI scaling than the secondary monitor, and 

the presentation screen was displayed on the secondary monitor, the presentation screen might not 

cover the entire screen. 

 Various UI issues regarding high DPI displays were fixed. 

 The template’s dynamic background primary and secondary color when hovering and primary and 

secondary color when selected were not stored properly in the template file. The colors might revert 

to the normal background primary and secondary color. 

 If the Score field or Participant field had to display a name that contained characters not available in 

the current code page, the name might not be displayed correctly. 

 In the text editor window, if you pasted text without formatting, the text might not be displayed 

correctly if it contained characters not available in the current code page. 

 When starting a session in a script that had an active internet connection and had a lot of identified 

questions, it might take a considerable amount of time before the New Session dialog was displayed. 

Also, the cursor didn’t change to an hourglass to indicate that the application was actually perform-

ing a lengthy task. 

 If a time bar was paused and its count down action was then performed manually (for instance, if 

the time bar was set to close the voting, it was paused before it could close the voting and then the 

voting was closed manually), the time bar would stay in its paused state. If the time bar was then 
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started again (for instance, the voting was opened again), it would continue from its paused state, 

rather than starting again from its starting position. 

 If you were voting with IVS-Online and your remote script was set to display the results, answer 1 

might not show any results if one of your answers contained an extra newline character at the end 

of its text. 

 Multimedia files that were placed into the script’s multimedia folder before they were inserted into 

the script, didn’t get their filename updated to the multimedia folder’s relative location. Instead, they 

kept their full path, which could cause the multimedia file to not get loaded anymore after the script 

was moved to a different location. 

 The option to continuously play a video fragment, didn’t just rewind and continued playing, but 

instead first stopped the video fragment before rewinding and replaying. This caused an unnecessary 

delay, during which the screen went black. 

 Inserting a picture from a file that had an unknown format, could lead to several error messages. 

 When applying a template to a script with an active internet connection, the information about the 

internet connection would be deleted. If you would reopen the script later, it could no longer connect 

to the internet. 

 On Windows 7 and 8, the VMR-9 is used to display a video on screen, instead of the EVR, because 

of a bug in the EVR on these systems. Due to a wrong setting in the VMR-9, it was not possible to 

display a video out-of-aspect. This has been corrected, so that videos on Windows 7 and 8 can also 

be displayed out-of-aspect. 

 When opening the voting on a question with a large number of actual answers, it could take a 

considerable amount of time before the voting was actually opened. 

 When importing example results, the total number of voted keypads was never set. Also the total 

number of votes and the total weight wasn’t set if the current slide didn’t contain a result chart. And 

the total voting weight wasn’t set if the current question wasn’t an identified question. For a normal 

question, the total voting weight should equal the total amount of votes. 

 Importing results from an older version could in some cases lead to an error message. 

 When the last slide in a script was set up to jump to another slide, this jump was not working when 

a presentation was started. After starting a presentation, the buttons and keyboard shortcuts to go 

to the next slide, were disabled as soon as you reached the last slide, even though this slide was set 

up to jump to another slide. 

Version 4.5.6 – Released 02/01/2018 
New features 

 In the connection wizard, there’s a new page that lets you customize the text and upload an image 

that is shown to the remote voters after they have logged in, when no question is currently open and 

no results are shown. You can also customize the text and upload an image that is shown in between 

questions, when no results are shown. 
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 In the connection wizard, when you create your users, you can now also enter a group name and 

voting weight for that particular user. This information will not be used on the remote server, but it 

will be included in the participants list, that you can download at the end of the wizard. 

 The start-up window, that allows you to open a recent script or create a new script, has been im-

proved. The window is larger and the two tabs are now simply called Recent and New. The preview 

images of the templates in the New tab are twice as large (note that user templates will not show a 

high resolution preview image unless they are saved again in the new format; this format is not 

compatible with older versions of the software, but you can still choose to save the template using 

the legacy format), and both standard and user templates are sorted on their name. Only the two 

empty script templates always appear first. The Recent Scripts Tab also shows preview images of 

recently opened or saved scripts. Preview images are created from the first slide in the script, once 

the script is saved. Scripts not containing a preview image will show a default image. 

 An Icon Handler Shell Extension was added, that shows the script’s preview image and the template’s 

preview image as an icon in the Windows Explorer. A script or template without a preview image 

will show a default script or template icon. An illegal script or template will show an empty page 

icon. 

Minor changes 

 The option ‘Relative to number of participants’ in the Result field was renamed to ‘Relative to number 

of voters’, because the percentage was actually based on the number of people that voted. A new 

option ‘Relative to number of participants’ was added, that calculates the percentage based on the 

number of participants, regardless of whether they voted or not. Other options under Type, that 

previously referred to participants, were also renamed to voters, and a new option ‘Total number of 

voters’ was added, to display the total number of people that voted. 

 In the Preferences dialog, on the View tab, the aspect ratio option was changed to a screen size 

option. It now contains descriptive names rather than merely ratios. Some exotic ratios have been 

removed, although they can still be set up using the custom option. 

Bug fixes 

 When a slide contained a lot of answers, it took a relatively large amount of time to build up the 

slide. 

 (IVS-Participant Registration only) When editing a user in advanced mode, the user defined value 2 

and 3 were not stored when they were changed. 

 When saving the script, the logo used for an internet slide was not saved to the images folder. If you 

moved the script to another computer, the logo might disappear, because the file was no longer 

accessible. 

 The Result field did not show correct results if voting weight was used and the results had to be 

calculated next in rank. 

 The Result field did not show correct results if voting weight was used and the results were displayed 

in percentages relative to the number of votes. 
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 The new link to the Scripts folder that was added to This PC, did not allow you to copy or move 

anything to the root folder. 

 In the connection wizard, on the user list page, the Import button allowed you to import both .txt 

and .csv files. However, while importing, only the tab character would be accepted as a separator 

character, even when you selected a .csv, where a list separator character should have been used. 

Known issues 

 If the laptop’s primary monitor is set to a different DPI scaling than the secondary monitor, and the 

presentation screen is displayed on the secondary monitor, the presentation screen might not cover 

the entire screen. Work-around: while the presentation screen is being displayed, go to File > 

Preferences and simply click OK. This will reset the presentation screen’s size, so that it will cover 

the entire screen. You need to repeat this step each time you leave the presentation screen and start 

the presentation again. 

Version 4.5.5 – Released 11/01/2017 
New features 

 On Windows 10, the Scripts folder will also be added to This PC, as an easy access shortcut to the 

actual Scripts folder. This shortcut will be created the first time you start IVS-Professional. 

 (IVS-Participant Registration only) The filter field added in the previous version is now case-insensi-

tive by default. To make it case-sensitive, prepend your search string with a \. For example, if you 

enter ‘G:A*’ as a search string, you’ll get all participants that are in a group that either starts with 

an ‘a’ or an ‘A’. If you enter ‘G:\A*’, you’ll only get participants that are in a group that starts with 

an ‘A’. 

 If you insert an image that has EXIF information (jpg and tiff), the image will automatically be ro-

tated, according to the rotation tag in the EXIF information. Note that rotation is performed on-the-

fly, and can be relatively slow for large images. 

Minor changes 

 The free version now also gives you access to internet voting. The email you receive after download-

ing the software, contains a link to request an internet account. With this account, you can connect 

to the IVS-Internet Server, to try out internet voting with up to three remote voters. You can even 

combine it with keypad voting, up to a total of 30 participants (keypads and remote voters com-

bined). 

 In the text editing window, the Rich Edit control was updated. Instead of sticking to Rich Edit version 

3, it now uses the latest Rich Edit version available on the computer. For Windows 7 this is version 

4.1, for Windows 8 it is version 7.5 and for Windows 10 (with at least update 1607) this is version 

8.5. 

 Two new buttons were added to the text editing window, that allow for new functions that were 

previously only accessible through keyboard shortcuts. The new All Caps button ( +  + ) 

allows you to change the selected text to all capitals. Note that this function does not actually change 
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the text into capitals, it merely displays the text in capitals. If you switch the option off, the text 

reverts to its original capitalization. The new Line Spacing button allows you to set the spacing be-

tween the text lines. The single, double and one and a half line spacing options were already avail-

able through the shortcut keys  + ,  +  and  +  respectively. New line spacing options are 

1.15, 2.5 and 3 lines. 

 In the text editing window, if you enable either bullets or numbering, the paragraphs are now also 

properly indented. And the font combobox no longer lists the vertical fonts (the ones normally start-

ing with a @), as vertical text reading is not supported. 

 When inserting an audio or video clip, the file type combobox in the open file dialog now shows the 

file types in the application’s language rather than in English. The file types are also sorted alpha-

betically. 

Bug fixes 

 (IVS-Participant Registration only) If the new filter option in the Participant Manager was used to 

filter a specific participant, editing this participant would actually edit the first participant in the list, 

instead of the first filtered participant from the list. 

 (IVS-Participant Registration only) On a computer with high DPI settings, the Participant Manager, 

search window and default participant window would have extra-large texts, because the text was 

accidentally scaled twice. 

 Crossing a question with  +  and then selecting a question from the list, would not function cor-

rectly or not function at all. However, crossing with a reference question using  +  would 

function normally. 

 In the properties for the result chart or the timebar, the font style selection box could display each 

font style multiple times for some fonts, and the font size selection box would not display the default 

font sizes for Type1 fonts. 

 On a computer with high DPI settings, the zoom combobox in the main window’s toolbar would 

have extra-large texts, because the text was accidentally scaled twice. This was also true for the ruler 

in the question, answer and text editing window. 

 The ruler’s indentation markers in the question, answer and text editing window were not scaled at 

all on computers with high DPI settings. This was also true for the color picker button’s color drop 

down window. 

 (IVS-Professional only) Although supposedly fixed in the previous version, the checkbox to remember 

your user name and password in the remote connection wizard, would still not be checked, even 

though your user name and password were already remembered. 

 If, during the installation of the software, you selected a custom setup and disabled the installation 

of the Script version 4.3.x/4.4 plug-in (which, as of this version, is now disabled by default), then, 

when saving a script, the script’s name would not appear in the application’s title bar and would not 

appear in the list of last saved scripts. Because the script’s name stayed unknown, it was also im-

possible to start a new session. As a work-around, you would need to close the script and re-open 

it. 
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 (IVS-Professional only) When creating a remote script with more than 1200 participants (give or 

take), the remote connection wizard would give an Access Violation and leave the application in a 

non-responsive state. 

 If the options ‘Results from high to low’ and ‘Last answer does not belong to total’ were both set, 

then not only the last answer, but also the first answer was ignored when calculating the total. This 

could lead to a total result of more than 100% in the result chart. 

 For questions without real answers, the option ‘Last answer does not belong to total’ would still 

display the results of the last answer in percentages. 

 When clearing non-existent files from the last used files list in the start-up screen, the non-existent 

files were cleared, but some existent files might still be grayed out. 

 When inserting a video fragment, it could take quite some time (about the same time as the length 

of the video fragment) before the video was inserted and also before the video was loaded when 

switching to the slide containing the video fragment. This was only true if the properties were set to 

display the first frame from the video and only happened for some specific video formats. 

Version 4.5.4 – Released 07/10/2017 
New features 

 (IVS-Participant Registration only) The Participant Manager now contains a filter field that allows 

you to specify a filter to limit the number of participants displayed in the list. Enter a text to only 

display participant with that text in their name. Prepend the text with a * to only show names that 

end with that text. Append a * to only show names that start with that text. Start the filter text with 

G: to search for a group name rather than a participant name. Note that the filter text is case-sensi-

tive. The same filter options can also be used in the Search Participant filter box. 

Minor changes 

 When duplicating objects, the clipboard is no longer used as an intermediate storage. Duplicating 

used to be a Copy immediately followed by a Paste. Duplicated items are now stored internally, 

which means that the contents of the clipboard are left untouched when duplicating items. 

 Printing a script layout with results would only support absolute values and percentages. Any other 

setting would fall back to printing absolute values. This has been extended, so all other settings 

(except the ‘legend’ setting) are now also supported when printing a script layout. 

Bug fixes 

 (IVS-Professional only) When importing example results into a script with identified questions, the 

score field could display ‘Invalid index’ even though the given index was in fact valid. 

 (IVS-Professional only) If you opened a script with an active internet connection by double-clicking 

on the script file in Windows Explorer, a window would pop up asking you to enter the password for 

your internet account (assuming you didn’t have IVS-Professional remember your password). When 

typing into the password field, the main menu would also start responding to the keys you pressed. 

If your password contained an ‘a’, for example, the new answer text dialog would pop up. 
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 (IVS-Professional only) A score field set to display the ‘Percentual score per number of voters’ would 

not display anything. This was only true for newly created scripts. For scripts made with a previous 

version, the score field would continue to work normally, unless you tried to change the field’s prop-

erties. 

 (IVS-Professional only) When a slide is set to be displayed on the internet as well, the slide’s image 

is sent to the internet as either a jpg or a png, depending on which one has a smaller file size. In 

case of a png, some parts of the image, or sometimes even the entire image, could end up being 

transparent and therefore not be visible on the internet. 

 In the print dialog, when you select to have a question crossed with a single question, the combobox 

listing the possible questions to cross with would stay empty. 

 (IVS-Professional only) In the properties of an answer, it was impossible to enter a negative score for 

this answer. When entering the minus sign, a pop-up message would say that the character you 

entered was not allowed because it wasn’t a number. 

 (IVS-Professional only) If  the display type of a score field was set to display the group name, opening 

the field’s properties would reset the display type to display the score. 

 (IVS-Professional only) If your script has an active internet connection and the remote script was set 

to ‘Anyone can vote after registration’ and you started a session with a participants list in .cdl format, 

the original participants list would be overwritten in .ipx format. This would make the participants 

list invalid the next time you tried to open it, because the extension said it would be a .cdl file, while 

it actually was an .ipx file. The participants list is now saved as an .ipx file when it gets rewritten. 

 (IVS-Professional only) If the participants list was rewritten, an error could occur when the location 

where the original list was stored, was not writable. The error is now ignored and the original par-

ticipants list will continue to be used, which means that newly registered internet users can still not 

vote. If you’re using this option, make sure that the location where the participants list is stored, is 

actually writable. 

 (IVS-Professional only) In some situations, the checkbox to remember your user name and password 

in the remote connection wizard, would not be checked, even though your user name and password 

were already remembered. 

 When right-clicking on a script file in Windows Explorer and selecting the ‘Open with IVS-Profes-

sional’ option, IVS-Professional might not be started at all, especially on 64-bit OSes. 

Version 4.5.3 – Released 03/10/2017 
New features 

 All software is now also available as a true 64-bit version. Note though that the 64-bit version does 

not support the older (blue) USB dongle. You either need to new (red) USB dongle or a temporary 

license to be able to use more than 30 keypads. 

 As of this version, the software is installed as a single language application. You can install additional 

language packs to use the software in other languages. The Preferences dialog has been extended 

with a new Language tab, where you can set the language priority order. This language priority order 

applies to all IVS applications and tools. 
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 The timebar has three new types that allow you to combine the bar or circle with the remaining time 

as text. The time is always drawn in the center of the bar or circle. 

 The printer settings dialog has been replaced with a modern print dialog. This dialog can be accessed 

from the File menu, or from the print setup dialog when printing a script. In the latter case, the new 

print dialog allows you print all slides, only the current slide, or a slide range/multiple slide ranges. 

The From Slide and To Slide comboboxes are automatically updated to reflect the selected setting. If 

you enter multiple slide ranges in the print dialog, only the first one will be shown in the From Slide 

and To Slide comboboxes, however, all slide ranges will be printed. If you manually change the 

comboboxes, then only the single slide range selected with the comboboxes will be printed. 

 (IVS-Professional only) A new question option was added to the Advanced tab of the question prop-

erties. This allows you to pose an approximation question, where the participants have to guess the 

correct value. You set up a correct value and a score for the correct value. Anyone guessing the 

correct value will get the full score. The more they deviate from the correct value, the less points 

they will get. If they deviate too much, the score will not get negative, unless you also check the 

‘Allow negative score’ option. 

Minor changes 

 The USB dongle is now preferred over the temporary license. If you have a temporary license and 

insert a USB dongle, you will get the license from the dongle. Remove the dongle to continue to use 

the temporary license, if it’s still valid. 

 (IVS-Professional only) The option ‘Also apply the above background settings to slides on IVS-Inter-

net’ was renamed to ‘Always use a solid fill background for slides on IVS-Internet’, to make it more 

clear what this option does. Because of the rewording, the option’s use is now inverted, so instead 

of checking it, you now have to uncheck it to get the same background on the internet as in IVS-

Professional. 

 When playing a video file, the image can now also be played out-of-aspect, meaning that the video 

image stretches when you change the multimedia object’s size. Due to a bug in the EVR on Windows 

7 and Windows 8, the image on these OSes will always be displayed keeping the original aspect 

ratio. 

 (IVS-Professional only) The option ‘Only apply the above background settings to slides on IVS-Inter-

net’ now really only applies to IVS-Internet. It will not show the background in the template either. 

 (IVS-Professional only) A new ‘Advanced’ tab was added to the question properties. The ‘Identifica-

tion group’ and ‘Default score’ options have moved to this new tab, and the ‘Default score’ option 

has been renamed to ‘Score for non-voters’ to better indicate its use. 

 (IVS-Professional only) The IVS-Internet Connection Wizard now has an option to remember your 

user name and password. If you open a script with an active internet connection, IVS-Professional 

will try to connect with the stored user name and password. If no user name and password were 

stored, you will be asked to enter them when you open the script. 

 (IVS-Professional only) If a PNG image is selected as a logo file for the internet script’s background 

slide, the file will now stay a PNG image, even if the file size of the converted JPG is smaller. This is 

to preserve transparency in the original PNG image. 
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 (IVS-Professional only) If an image is used as the slide’s background and the image position is set to 

Fill, the image will now be centered on the slide for internet users, instead of left aligned. This re-

sembles the way the image is displayed in IVS-Professional. 

Bug fixes 

 (IVS-Professional only) If an answer was marked as a correct answer, and the option ‘Only apply the 

above background settings to slides on IVS-Internet’ was used, the answer would still get a back-

ground color applied in IVS-Professional. This made it quite obvious to the user what the correct 

answer was. 

 If, when closing the voting, some third-party application (such as a virus scanner) had locked the 

result files, the final result file would get damaged, so that it would no longer be able to show any 

results for that particular question. 

 If the application was closed while the voting was still open, the result file would be left in an unfin-

ished state. After importing the same session again, the final result file would get damaged because 

of that unfinished result file, so that it would no longer be able to show any results for that particular 

question. 

 A field of type ‘Result’ would not display any results if the option ‘Last answer does not belong to 

total’ was selected and there were no results available for any answer except the last one. 

 When you go to the last slide or the first slide, the button to go to the last/next or first/previous slide 

would still be enabled, suggesting that you could still go further back/forward. 

 (IVS-Professional only) The option ‘Only apply the above background settings to slides on IVS-Inter-

net’ was not stored in the template. 

 If an image was used as the slide’s background, and the image position was set to either fill, stretch 

or tile, the slide’s background color was not drawn. This background color would normally not be 

visible, because the image would fill the entire slide area. However, if an image with transparency 

was used, you would see portions of the previous slide in the image’s transparent areas. 

 If the mean and/or standard deviation were enabled in the template, the displayed values in the 

template were wrong. They would either both be zero, or display some random value. 

 When saving a template, the primary color selected under ‘Background when selected’ in the Ad-

vanced tab of the answer’s properties would get overwritten with the secondary color. 

 (IVS-Professional only) When a script was saved to the internet, the answers were sent in the order 

in which they appeared on the slide rather than the actual numbered order. After re-arranging an 

answer’s order, the answers on the internet might appear in a totally different order as they appeared 

on the slide. 

 (IVS-Professional only) When a logo was used on an internet script’s background slide, and that 

logo’s file size was too large, an ‘Invalid pointer operation’ could occur, which made it impossible to 

open the script again. 

 (IVS-Participant Registration only) The application state was not properly initialized to ‘Register’, so 

you had to selected the ‘Register’ state from the menu first, before you could start registering. 
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Version 4.5.2 – Released 07/19/2016 
Bug fixes 

 If a device was attached to or removed from the computer, you could get a notification ‘This appli-

cation has stopped working and needs to be closed’. IVS-Professional would then be closed without 

giving you a chance to save your work. 

 If one of the last used scripts came from a remote computer and that computer was no longer ac-

cessible, IVS-Professional would freeze for about 20 seconds during startup, before showing you the 

startup dialog. 

 If a license on a USB stick was connected, and the license file had somehow become corrupted, an 

‘Out of memory’ error would be displayed upon startup, and the application would not be completely 

initialized. An Access Violation could occur anytime the license needed to be read, or when the ap-

plication was closed. 

Version 4.5.1 – Released 06/15/2016 
Minor changes 

 The ‘Result’ field now has an extra option to display the total result including the last answer. This 

option always displays the result of all answers, regardless of the ‘Last answer does not belong to 

total’ setting. 

 The ‘Connection’ menu is now always shown, even if no internet license is available. The only option 

available is the ‘Info’ option, which gives more information about online voting. 

 The way keypads are initialized when you have connected more than once Base Station has been 

simplified. You are still asked if you want to initialize keypads for each connected Base Station. If 

you click Yes, the standard Initialization window appears. If you are finished initializing keypads for 

this Base Station, you can now click the Stop button in the Initialization window. There is no extra 

window needed asking you to click OK to stop initializing. 

 If you right-click on a script file in Windows Explorer, that was saved by an application in a different 

language than the one currently installed, the Open action would not be the default action, because 

the application in the other language was not considered the preferred application. This has now 

been changed, because the application is perfectly capable of opening a script saved in another 

language. 

 All executable files are now dual signed: once with a sha-1 signature and once with a sha-256 sig-

nature. 

 Updated the drivers for the Base Station to version 2.12.16.0. 

Bug fixes 

 (IVS-Professional only) Voting on a group question turned out to be impossible, because this would 

give a List Index out of Bounds error message. The group question would accidentally take the sec-

ond vote from each keypad although keypads are only allowed to vote once. 
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 When the number of bars to show in the chart was set so that the last answer wasn’t shown, the 

total result count would still include the last answer, regardless of whether the option ‘Last answer 

does not belong to total’ was enabled or not. 

 (IVS-Professional only) When creating an IVS-Internet script, that didn’t have a specific start and end 

date, the time should have been set to 00:00, but that only happened when you were in the same 

timezone as the server and DST was not in effect. 

 (IVS-Professional only) When a temporary license code was entered that included the IVS-Internet 

option, the menu wasn’t updated to show the Connection menu. It was only shown when opening 

a script or clicking somewhere in an already opened script. 

 (IVS-License Manager only) When a keylock expired, it was no longer possible to enter a new license 

code. That made it impossible to set a new expiration date for the keylock. Note that expiring key-

locks are currently not in use. 

 Printing to a printer (not to file or bitmaps, etc.) would fail in some cases. 

 Calculating the results would take exponentially longer for an identified voting when a) there were 

more participants in the participants list and b) the participants were allowed to vote more than once 

on the same question. 

 When uninstalling the application, the InstallDir was left behind in the registry. This InstallDir is used 

by Windows Explorer to determine the installed application when double-clicking a script file. This 

could cause a script to not open anymore, because the application to open the script had in fact been 

uninstalled. 

 (IVS-Participant Registration only) When importing participants, any alternate group name or weight 

was not imported if only one of the two differed from the default. They were only imported if both 

the group name and the weight were different from the default. 

Version 4.5 – Released 03/18/2016 
New features 

 (IVS-Professional only) The IVS-Card Link and IVS-Lite Link application are going to be replaced with 

the new IVS-Participant Registration application. 

 A new Answer Manager was added to quickly move the answer texts up and down the available 

answers. Note that this only moves the texts, not the answer objects itself. 

 The Background tab is now also available for question and answer objects. Also a new option was 

added to the Background tab to let you set a radius to let the background have rounded corners, and 

two options were added to set the transparency of the selected primary and secondary colors. The 

options to let the background color of a participants field change based on the given answer have 

now been moved to a separate ‘Interactive background’ tab. 

 (IVS-Professional only) IVS-Professional can now connect to IVS-Internet which allows your audience 

to not only use keypads to vote, but also any device that can connect to the internet and display a 

web page. Use the ‘Connect to internet’ option in the new ‘Connection’ menu. Note that you need 

a license to use this option, you need to have an account on the IVS-Internet server or use your own 
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dedicated server, and you need to do a custom install to install the IVS-Internet Gateway plug-in, 

that can be found under Shared Components > Plugins > Communication. 

 After having initialized keypads, you are no longer asked to save a list with keypads. Instead, the list 

is automatically saved. You can still save your own list by using the ‘Save initialized keypads’ option 

from the ‘Communication’ menu. 

 When starting a presentation, you are no longer asked to start a session. Instead, when a Base 

Station is connected and initialized, you are required to start a session. If you don’t start a session, 

you cannot start a presentation. This is to prevent you from starting a presentation without being 

able to see the voting results. 

 The script plugins were updated, which results in an overall performance improvement, especially 

for larger scripts. It also allows undo information being retained after saving the script. This means 

you can still undo any changes, even after saving the script. 

 As a result of the script plugins update, the way slides are moved in the slide sorter has also changed. 

If you move a slide backward, the moved slide is placed before the slide you drop it on. If you move 

a slide forward, the moved slide is placed after the slide you drop it on. 

 Added support for a license file stored on a removable disk rather than using a keylock. 

 The ‘Participant’ field cannot only show the participant’s name, but can now also display the partic-

ipant’s group, weight, vote and three user defined values. 

Minor changes 

 Improved the speed with which the result and cumulative fields are calculated, especially for a ques-

tion with a relatively large number of answers. 

 Changed how the font for the question and answer number is determined. It is now always taken 

from the last character of the text (usually a carriage return value). This is consistent with how Mi-

crosoft Word determines the color of a paragraph number. Note that this might be a breaking change 

for some older scripts. 

 Added more options to enter accented characters using a US keyboard layout. Press  + , followed 

by a, e, i, o, u, y (or their capitals) to get an acute accent. Press  + , followed by a, e, i, o, u (or 

their capitals) to get a grave accent. Press  +  + , followed by a, e, i, o, u (or their capitals) 

to get a circumflex accent. Press  +  + , followed by a, e, i, o, u, y (or their capitals) to get 

an umlaut accent. Press  +  + , followed by a, n, o (or their capitals) to get a tilde accent. 

Press  + , followed by d or D to get ð or Ð respectively. Press  + , followed by c or C to get ç 

or Ç respectively. Press  + , followed by o or O to get ø or Ø respectively. Press  +  + , 

followed by a, A, o, O or s to get æ, Æ, œ, Œ or ß respectively. Press  +  + , followed by a 

or A to get å or Å respectively. Press  +  +  +  to get ¡, or  +  +  +  to get 

¿. These key combinations correspond to the ones used in Microsoft Word. Please note that the given 

combinations are for a US keyboard layout only. Other keyboard layouts may use other keys or com-

binations to get accented characters. 
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 (IVS-Professional only) For any field type where an answer has to be selected, it is now also possible 

to select answers even if there are no answer objects. In this case the answer list simply displays 

‘Answer 1’, ‘Answer 2’, etc. for as many answers as indicated in the properties of the question. 

 When trying to initialize a Base Station at application start-up, that’s not connected anymore, a 

warning is displayed. On Windows Vista and higher, this warning has less text, with a ‘More infor-

mation’ button to display the rest of the text, and it contains a checkbox to not display this warning 

anymore. 

 When opening the voting without having started a session, a warning is displayed that now allows 

you to cancel the open voting request to start a new session. On Windows Vista and higher, there is 

a checkbox to not display this warning anymore, until the application is restarted. 

 When aligning answers to the bars in the chart, the alignment now takes into account the first dis-

played bar in the chart and whether the chart displays its results from high to low. In the latter case, 

the answers are also rearranged from high to low. 

 The preview images of the templates in the start-up screen now have a border around them, which 

makes templates with a white background better visible. 

 Added an ‘Open scripts folder’, ‘Open Keypad Lists Folder’ and ‘Open Participants Lists Folder’ option 

to the Help menu to quickly open the folders in the Windows Explorer. 

 (IVS-Professional only) During an identified voting using RF-II keypads where correction was not 

allowed, one could still ‘correct’ his votes by putting the chip card in another keypad and vote again. 

This has been changed. When correction is not allowed, voting with the chip card in another keypad 

will not overwrite existing votes from the original keypad. When correction is allowed, you can still 

overwrite previous votes by putting the chip card in another keypad. 

 The results are now always immediately stored, even if the current slide is not an interactive slide. 

This has the side effect that some fields on the current slide are updated with new information when 

you change slides (i.e. go to some other slide and then return to the slide where you opened the 

voting) while the voting is still open. But this was already the case for interactive slides. 

 The timebar has been updated to use GDI+ to draw itself. This results in a smoother looking timebar, 

especially the circular one and the textual one. The textual one now uses the time separator as set 

up in Windows instead of always using the colon. 

 When a multimedia object is inserted and a video file is selected that is larger than the slide, the 

multimedia object is now resized to fit within the slide. 

 When a multimedia object is inserted and a video file is selected, the first frame of the video file will 

be displayed instead of the default black rectangle. You can change this in the properties of the 

multimedia object, where you can now also select to display a transparent placeholder for as long 

as the video file is not playing. 

 Audio or video files used in the timebar or the multimedia object, that are smaller than 50 MB, are 

now copied to the Multimedia folder in the script folder when you save the script. Files larger than 

50 MB will remain in their original location and the script will link to this original location. If you 

want to include larger files in your script, copy them to the Multimedia folder first and then insert 

them in your script by selecting them from the Multimedia folder. 



RELEASE NOTES FOR IVS-PROFESSIONAL 

COPYRIGHT © 2024 INTERACTIVE VOTING SYSTEM B.V. 27  

 Some options on the Answer properties page were moved to a separate Advanced page. These op-

tions control very specific behavior and shouldn’t be allowed to be changed too easily. 

 The File menu now lists eight last used files instead of four. 

 (IVS-Base Station Locator only) The application now searches for Base Stations on all available net-

work adapters. 

 The text editing window for entering the text for a question, answer or normal text, now takes over 

the background color of the question, answer or text, instead of using the slide’s background color. 

 (IVS-Card Link only) When no reader has been selected yet, and one or more readers are connected, 

the first available reader is now selected by default. If no reader could be initialized, the ID label now 

reads ‘No reader’ instead of ‘No card’. 

 In the Chart properties, the result type ‘Percentage relative to first vote’ was renamed to ‘Percentage 

relative to total voters’ because this better describes how the percentage is actually calculated. 

 In the Chart properties, an extra result type ‘Absolute/Percentage relative to total voters’ was added, 

which displays both the absolute number of votes, and the percentage of votes relative to the total 

number of voters. 

 On the View tab in the Preferences, a new option was added to the multiple monitors list. The option 

‘Automatic’ automatically chooses a monitor to display the presentation on. If only a single monitor 

is available, it will use that one. If multiple monitors are available, it will use the first non-primary 

monitor. 

 (IVS-Lite Keypad Information only) When checking the keypad’s battery status, the keypad itself is 

no longer actually initialized. This means that you won’t see the green led anymore, and the keypad 

stays on its original channel, instead of changing to battery checking channel (channel 5). 

 In the properties of a question, if you set the question to be a group question, the option to display 

a mean value is disabled, because it doesn’t make much sense to display a mean value of group 

names. However, the option to display the standard deviation was not disabled, although it makes 

just as much sense as displaying the mean value. Both options are now disabled when you select a 

group question. 

 In the properties of the Result you can now also select the display the chart top-to-bottom as well 

as right-to-left. This option differs from the option ‘Answers from high to low’ found in the properties 

of the question, because it also turns around the axis, whereas the ‘Answers from high to low’ only 

turns around the bars. If you switch on both options, the bars will be turned around twice, effectively 

staying unchanged. 

 An image pasted from the clipboard is no longer inserted as a bitmap image, but as a JPG or PNG 

image instead, depending on which one has the smallest file size. 

 To display a video file, the multimedia object now uses the Enhanced Video Renderer when available 

(Windows Vista and higher). With the current settings, the EVR is not able to display a video out-of-

aspect. This means that if you manually scale the multimedia object, without maintaining the aspect 

ratio of the original video, the video will still be displayed with its original aspect ratio. 

 Improved the icons displayed by the multimedia object. A speaker icon is shown when the selected 

file does not contain any video. A yellow triangle icon with exclamation mark in the bottom left 

corner means that the given file could not be found. A red circle icon with cross means that the file 
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could not be rendered (which usually means that no DirectShow codec is installed that can play the 

selected file). A green circle icon with triangle means that the multimedia object is currently playing 

an audio file. A yellow circle icon with two vertical bars means that the multimedia object has been 

paused. 

 The timebar now only uses the DirectSound Renderer to play the sound files. In some cases this will 

speed up the loading times of the sound files. 

 The script’s aspect ratio is now also stored in the templates. This means that you can now save both 

normal and widescreen templates. A default widescreen template, based on the default normal tem-

plate, is now also provided. 

 Improved the display of the splash screen, status bar, main menu, popup menus and wizards on 

systems with a higher DPI setting. 

 (IVS-Professional only) All fields that work with name filters or group name filters now allow you to 

use the ‘*’ wildcard to match any remaining string. E.g. ‘red*’ will match any name starting with 

red. ‘*red’ will match any name ending in red. ‘*red*’ will match any name containing red. For name 

filters, the wildcards are implicitly added to the beginning and end of the given string, if no other 

wildcards were entered. If you don’t want to use implicit wildcards, put the string between single 

quotes. 

 The position and size of the main application window is stored when you close the application and 

used again the next time you start the application. The preferences window remembers which tab 

you selected last, and selects the same tab the next time you open the preferences. The reapply 

template window remembers your current selection and used that same selection the next time you 

open the reapply template window. 

 (IVS-Professional only) Whenever the FieldText.xml is updated, the current slide is automatically re-

freshed to reflect any possible changes in the text fields. 

 (IVS-Professional only) In the properties of a field of type ‘Result’, the option ‘Number of digits’ has 

been renamed to ‘Show decimal places’ and the maximum value has been increased from 5 to 9 

decimal places. 

 (IVS-Professional only) In the properties of a field of type ‘Result’, a new option ‘Precision in decimals’ 

was added, which allows you to display absolute values with decimal places. This option is only 

useful for identified voting with voting weight. This option divides the total number of votes by any 

power of 10 to get the desired number of decimals. This implies that you must multiply all your 

voting weights by the same power of 10 to get correct results. When this option is used and set to a 

value higher than 1, the option ‘Show decimal places’ can be used to determine the actual number 

of decimal places shown. The maximum number of decimal places is always one less than the given 

precision. 

 (IVS-Professional only) Four new options were added to the ‘Result’ field to also display a superma-

jority of three quarters instead of only two thirds. 

 After starting a session or importing an existing session, the new option ‘Edit session’ in the Voting 

menu lets you edit the session’s name and (IVS-Professional only), with an identified session, lets 

you change the list of participants to use. Please be careful with the latter, because changing the list 
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of participants for a session that was already partly voted, could potentially change the results of the 

already voted questions. 

 In the properties of a multimedia object, it is now possible to indicate that the multimedia object 

should be played continuously. 

 In the start-up screen, the eight last used scripts are listed. If one of the scripts is unavailable, it will 

be greyed out and you won’t be able to click OK to open a script that doesn’t exist anymore. 

 On the ‘View’ tab of the Preferences screen, three new options were added to the aspect ratio. You 

can now also choose a double full HD resolution (32:9) and a triple full HD resolution (48:9). The last 

option allows you to enter a custom resolution. Note that whatever resolution you enter will be 

treated as 100% screen size. If the given resolution doesn’t fit on the screen, it will be resized (either 

enlarged or reduced) to make it fit. 

 A popup menu was added to the last used scripts list in the startup screen that allows you to remove 

a specific item, non-existent items or clear the entire list. 

 The help files were updated to reflect recent changes in the manuals. 

Bug fixes 

 When copying/pasting answers that had been re-arranged, the answer numbering of the pasted an-

swers could get all mixed up. 

 A Result field could give a wrong result (either absolute or in percentages) if the question it belongs 

to could be voted on more than once and one of the first votes of a particular participant was not 

received or was skipped by the participant himself. 

 A Name field could lead to an Access Violation if the voting on one of the questions was opened and 

then cancelled. 

 If a keypad goes out of reach during an opened voting and comes back into reach when the next 

voting is already opened, the keypad will still transmit its vote of the previous question. If this vote 

was now invalid (e.g. the keypad voted a 5 on the previous question, but the current question only 

has 3 answers), it would still be handled, resulting in the total vote count not corresponding with 

the vote count in the chart. 

 The Result field would not display anything if the results contained a vote that was higher than the 

current number of answers. This could happen for a question that was already voted and then had 

one of its answers removed. 

 When filtering the Score field on a specific group name, participants not belonging to this group 

would still be added to the list, with a score of 0 points. 

 When displaying the answers from high to low, the chart would always end with the first answer, 

instead of the answer set as the First displayed bar. (This change was reverted, because the old 

behavior turned out to be correct.) 

 When an invalid user template was found, the template was still added to the list of templates in 

the start-up screen, with the preview image of the previous template. 

 If an image was used as the background of the text object on the template, the image was not scaled 

properly. 
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 An image used as the background of the text object on the template was not saved to the images 

folder when the template was saved. Instead it remained on the original location. 

 When a timebar was set up to close the voting, but the voting was opened on a different slide, 

closing the voting would return to the slide where the voting was opened and then cause an Access 

Violation. 

 When the option “Calculate answers next in rank” was combined with the option “Show percentage 

of first votes”, the percentages were not calculated correctly, because the total number of first votes 

was not multiplied by the ranking order. 

 When the option “Show percentage of first votes” was used in combination with multiple answer 

groups, the first vote could have been reset when any of the other votes came from a different 

answer group. In that case the percentages in the result chart would be wrong, because the number 

of first votes would be less than the actual number of voters. 

 If a template was saved that used an image as a background, and later another template was saved 

that used a different image as a background, but the filename was the same (e.g. background.jpg), 

the first background image would be overwritten. 

 When comparing multiple questions in the same result chart, where the results should be shown as 

a percentage relative to the total number of voters, only the first question in the chart would have a 

percentage relative to the total number of voters, all the other questions would have a normal per-

centage (i.e. relative to the total number of votes). 

 Voting weights of more than 2,147,483,647 were not handled properly, resulting in the weight being 

reset to 1. 

 If the “Result” field had a filter applied to only count the participants from a certain group, this filter 

was ignored when the field was set to display the results relative to the number of participants. 

 (CC100 only) When the correction key was used for a Y/N question, the vote was corrected, but the 

vote count was not decreased. 

 On the Presenting tab of the Preferences window, if you selected to use a presenter that alternately 

sends an F5/Esc, the selection was not remembered the next time you opened the Preferences win-

dow. 

 (IVS-Professional only) If a question could be voted on more than once, and had answers in different 

answer groups, it was possible to vote on the same answer twice, even if that was not allowed, by 

voting with the same chipcard in two different keypads. 

 If the software was accidentally started twice, the second instance could remove the temporary li-

cense, because it was made invalid by the first instance. 

 When starting a presentation by pressing F12 for a script with identification, the Start Session dialog 

would appear. After selecting a participants list with the browse button, the input focus was set to 

the main window instead of to the Start Session dialog. This would allow you to press  again, 

which would bring up a second Start Session dialog. After completing the second dialog, the presen-

tation screen would appear, but it wouldn’t allow you to use any shortcut keys, because in the back-

ground, the first Start Session dialog would still be active. 

 When applying a different template containing a background image, the image of the previous tem-

plate would still be shown if the image of the new template could not be found. 
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 When running a presentation on the secondary monitor, you could open a second script and import 

example results into this script. The presentation screen would then display the text ‘Example results’ 

in the bottom right corner, even though the script on the presentation screen did contain real results. 

Likewise, if you would start a presentation from a script containing example results, you could open 

a new script, import results into that script and then stop the session. This would make the text 

‘Example results’ disappear from the presentation screen, even though the script on the presentation 

screen was still using example results. 

 When starting a new identified session, the participants list was copied to the session folder. Alt-

hough this XML file said it was stored as UTF-8, it was in fact stored as Windows-1252. This would 

make this XML file incompatible with other applications that expected the file to be UTF-8, for ex-

ample the new IVS-Participant Registration application. It could also cause data loss, because not all 

characters available in UTF-8 are also available in Windows-1252. The participants list is now written 

as a UTF-16 XML file. Note that this is a breaking change. Older versions of the software will not be 

able to read this XML file, effectively not being able to import identified sessions written by newer 

versions of the software. 

 When a question and chart were copied and pasted to another slide, or if any property of the chart 

was changed, the ‘Adjust bar width to’ option of the chart would no longer follow the template. 

 Fixed various memory leaks. 

Version 4.4.14 – Released 03/11/2013 
New features 

 Added an extra chart type that displays the answer legends in the chart’s labels. This is useful for a 

multiple-choice distribution. 

 (IVS-Professional only) Added an extra option to the answer properties. When the option “This an-

swer repeats the given answers of question x” is enabled, choosing this answer will automatically 

repeat the answer given for a previous question. Set the number of the question from which you 

want to repeat the answers, or leave it to zero to repeat the answer from the previous question. 

 (IVS-Professional only) All fields that work with group names now allow you to enter multiple group 

names, separated by a semi-colon. You must enter the exact group name, which is case sensitive. 

Note that this is a breaking change: if you open a script, made with an older version, that relies on 

only part of the group name, then this script will no longer function correctly. You will have to modify 

the fields to include the entire group name(s). 

 (IVS-Professional only) Changed the way the Score field works. You can now also display a top-5 of 

participants within a certain group. Just select the participant number and group number. Enter a 0 

if you’re not interested in a certain group. Enter a 0 for the participant if you want to see totals for 

the group. Enter a 0 for both to see the totals of the entire group. You can also filter on specific 

groups: just enter the group name or names, separated by a semi-colon. 

 (IVS-Card Link only) The Communication menu was renamed to Readers menu. The option to refresh 

the readers had been removed because the application now automatically detects the arrival and 

removal of smart card readers and updates the menu accordingly. 
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 (IVS-Card Link only) A new Mode menu has been added, which allows you to set the programming 

mode. De default mode is “Add cards”, which adds the cards inserted into the reader to the list of 

participants. A new mode is called “Remove cards” which allows you to quickly remove cards already 

added to the list of participants. 

 The properties dialog for answers was compacted to make more room for extra options. Instead of 

separate sections for ‘Jump’, ‘Score’, ‘Grouping’ etc. these options are now all consolidated under 

the section ‘Answer options’. 

 (IVS-Professional only) Added a new option to the answer properties. With the option ‘Group results 

with answer’ you can choose to have the results of this answer added to the results of some other 

answer. The answer itself will then not show any results. 

 (IVS-Professional only) Introduced a new participants list format. This version not only supports the 

old format (.cdl extension) but also a new format (.ipx extension). The new format is an XML-file 

that introduces several new options. It is now possible to enable or disable a participant without 

having to remove the participant from the list. It is also possible to define multiple identification 

groups per participant. Each identification group allows you to change the voting weight and/or 

group name, or enable/disable the participant. You can then choose which identification group you 

want to use for each question. 

 (IVS-Professional only) Added a new option to the question properties. With the ‘Identification group’ 

option you choose which identification group from the participants list you want to use for this ques-

tion. This allows you to give participants a different weight or put them in a different group depend-

ing on the question. 

 Results are now stored in a new format. The actual result files are still compatible with previous 

versions, but the information stored per session is now stored in an XML-file rather than an INI-file. 

This allows for more information to be stored. For example, the session now keeps track of the exact 

time a question was opened and closed. 

 The Keylock Update Utility and the Keylock Test Utility have been replaced with the new IVS-License 

Manager. 

 If you start a presentation, the computer is prevented from entering stand-by state, blanking the 

screen or starting the screen saver when no user input is detected during a certain period of time. 

Only when you leave the presentation screen, the computer is allowed to enter stand-by state, blank 

the screen and start the screen saver. 

 When the computer goes to a stand-by state, the Base Stations are automatically disconnected to 

prevent any problems with the USB port while the computer is in a stand-by state. As soon as the 

computer resumes from the stand-by state, the Base Stations are automatically re-initialized and a 

keypad list is loaded when necessary. 

Minor changes 

 Replaced the almost ten years old default templates (they were introduced in IVS-Basic 4.2, dated 

May, 2003) with a few more modern looking templates. 

 The communication wizard now detects the arrival and removal of serial ports and automatically 

updates the available ports to choose from. 
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 A chart without any results would still show a single zero on the axis. This zero has been removed. 

 The option “Last answer does not belong to total” now really refers to the last answer and not the 

last bar. These two used to be the same, but since it’s now possible to have less bars in the chart 

than there are number of answers, the two are not necessarily the same. Also when combined with 

the “Display answers next in rank” function, this option still refers to the last answer, regardless of 

where it ends up in the chart. 

 The “Jump to slide” option in the properties of the slide and answer now also allows you to make a 

relative jump. Start the value with a ‘+’ or ‘-‘ to make it relative to the current slide. A relative jump 

is not affected by any slide insertions or removals. E.g. if you set the next slide for slide 1 to ‘+3’, it 

will jump to slide 4. Even if you insert a new slide between slide 2 and 3, it will still jump to slide 4, 

which is now the original slide 3. 

 A new keyboard shortcut  +  +  was introduced to go to the next slide, regardless of the “Jump 

to slide” option. E.g. if you are on slide 4, which is set up to jump to slide 7, pressing  will go to 

slide 7, but pressing  +  +  will go to slide 5. 

 Printing a script layout now uses the complete width of the page and uses digit grouping in the 

results for better readability of larger numbers. 

 Improved the speed with which the score fields are calculated, especially when the score must be 

calculated from a relatively large number of questions with a relatively large number of answers. 

 Improved the painting of the background of the slide or text object. Painting is now done using GDI+, 

which is faster, produces a better image quality and offers more options. GDI+ supports only these 

image types: BMP, JPG, PNG and TIFF. If you use any other image type, which is not recommended, 

painting the background will revert to the old method using GDI. 

 The Shell Extension is now also available in a 64-bit version. This is necessary for 64-bit OSes to be 

able to display the ‘Open with IVS-Professional’ option when right-clicking on a script file. The Shell 

Extension is now also multilingual on Windows Vista and higher. This means that regardless of the 

language of IVS-Professional that you install, the shell options (e.g. file type descriptions) are now 

displayed in the language of the OS (currently only English, German, French and Dutch are supported; 

for other OS languages the options are still displayed in English). 

 Improved the start-up splash screen. It now also shows what the application is doing while starting 

up. You can click on the splash screen at any time to make it go away. 

 When dragging and dropping files onto the application, all types of script files, image files and mul-

timedia files are supported. Previous versions only allowed script files with the .isf extension. This 

version allows all supported script files. If you drop an image file or a multimedia file onto the appli-

cation, it will be inserted into the current slide. 

 The handles, with which you can resize an object, are now slightly bigger and the corner handles are 

round to indicate that corners can be moved in a vertical and horizontal direction. 

 If you hold the Shift key while moving an object, you can move it either horizontally or vertically. 

 The legend text of a question changed to (a shorter version of) the question text whenever you 

changed the question text. This has been changed so that the legend text now only changes if you 

hadn’t manually changed it into something else. 
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 The options Select all and Deselect all from the Edit menu are now also available on the template 

slide. 

 When you leave a slide while the voting is open and a time bar is running, the time bar automatically 

starts running again when you return to this slide. Note that the remaining time is reset, so the time 

bar starts again from original time that was set. 

Bug fixes 

 In the properties of the chart, the Number of decimals was not enabled even though the type was 

set to Percentages. Changing the type to Absolute and then back to Percentages would enable it. 

 When using a temporary license, the time left as indicated in the splash screen was the time left from 

the previous start-up instead of the current start-up. 

 When using a serial RF-I or RF-II Base Station connected with a USB-to-serial converter cable, the 

Base Station would not always initialize. When it did initialize, it would soon go offline. 

 With multiple charts on the same slide and linked to the same question, one displaying normal re-

sults, the others displaying a crossing, changing the properties of one chart also influenced the re-

sults displayed in the other charts. For example, the chart displaying normal results would suddenly 

display crossed results as well. 

 With an identified session already started, initializing the Base Station using Communication > Set-

tings would cause that no votes were received and the Base Station went offline after trying the 

close the voting. Initializing the Base Station with the Communication > Initialize cluster option 

would not cause this strange behavior. 

 Voting on an identified question with multiple Base Stations without having started a session, could 

sometimes cause the Base Stations to stop sending votes at all. Trying to close the voting would 

make the Base Stations go offline. The functionality of being able to vote without having started a 

session has now been completely removed. You can only see the results after having started a ses-

sion, regardless of whether you have an identified or an anonymous question. 

 When using the option to not show all bars in a chart, the percentages of the bars would change. 

The total amount of visible bars would add up the 100%, instead of the total amount of available 

bars. 

 Using the options “Cross/Compare to 100%” and “Last answer does not belong to total” would 

leave some ridiculously large values in the last bar. 

 When only one bar was visible in the chart, the option “Normalize to 100%” would take that single 

bar as 100% causing no normalization to occur. 

 Opening the properties of a question and clicking OK without changing anything would make the 

question options no longer respond to changes made in the template. 

 (IVS-Professional only) The Base Station locator could remove ports that were just added when link-

ing the Base Stations twice and choosing a different starting port for the second time. 

 (IVS-Professional only) When displaying an average score in the Score field, the results were inaccu-

rate when some people had not voted. 
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 When a combination of a Lite Base Station and another type of Base Station was initialized, you 

wouldn’t be asked to load the last used list upon application startup, which would leave the Lite 

Base Station without any initialized keypads. 

 When exporting to a CSV, the results would all end up misaligned when the second question had 

more answers than the first question, but less answers than the number of voters. 

 When exporting individual results or individual scores, you might end up with two export files, one 

for identified results and one for anonymous results, even if the script was fully anonymous. This 

could happen after starting a session, then importing example results and then importing the original 

session again. 

 (English version only) When the Base Station did no longer respond, the message “Format '%d' 

invalid or incompatible with argument” was displayed rather than a message saying that the Base 

Station didn’t respond. 

 When a question or answer was inserted without any text, and the vertical alignment was set to 

center or bottom, the question or answer number wouldn’t show. 

 When a non-English version of IVS-Basic or IVS-Professional was installed for the first time on an 

English version of Windows, a folder called My Scripts was created in the user’s profile. However, 

IVS-Basic or IVS-Professional would look for the localized version of that folder, which could not be 

found, and therefore they would open the Documents folder instead. 

 If a new slide was inserted with the New slide option from the Insert menu, and the option ‘Duplicate 

all objects on slide’ was used that had to copy a question to the newly inserted slide, any fields 

referencing a question range after the newly inserted question were not updated to reflect the extra 

inserted question. For example, if a score field was set from question 1 to question 3, and you would 

add an extra question between question 2 and 3 using the method mentioned above, the field would 

remain set to question 1 and 3, instead of being updated to question 1 and 4. 

 After voting on a question on a slide that contains more than one result chart, with at least one of 

the charts linked to the current question, any crossing or comparison would only be performed on 

the chart belonging to the current question. Repeating the crossing or comparison would then per-

form on the remaining charts as well. 

 When resizing the right side of an object, the object could also move slightly upwards and/or to the 

left. 

 When switching to the next slide and then back again while the voting was still open, the results 

received so far would already be shown, even if the result diagram was not set to be interactive. 

 (IVS-Card Link only) If some cards were already programmed and a name list was imported, the first 

name of that list was shown in the name field. However, if you clicked the Start button, the second 

name would be shown, which would make it impossible to program the first name from the list. 

 If you opened the voting in the presentation screen while having an animated GIF on the slide, the 

voting would open, but in some cases the status could hang on Opening. It was then no longer 

possible to close the voting, because of the status still being Opening. Going back to the edit screen 

would change the status to Opened and would allow you to close the voting. 

 If the option Calculate answers next in rank was checked, and you were allowed to give three an-

swers for example, the first answer was not rated with three point, but with only one point. After 
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giving your second answer, your first answer would be rated with two points and the second with 

one point. Only after giving your third answer, the first would be rated with three points. So if you 

decided to only give one answer, this would be rated with one point instead of three. 

 When printing to JPEG, PNG or Bitmap, if you cancelled the folder selection dialog and then decided 

to print to a JPEG, PNG or Bitmap again, printing would fail. 

 When copying an image object to the clipboard, not only the object itself, but also the entire image 

should be copied to the clipboard. The latter was not the case anymore, and could, in some circum-

stances, lead to the application shutting down unexpectedly. 

 Changing the default printer using the Settings button in the print options dialog could only work 

for the first time something was printed. When printing again, the default printer might be used 

again. 

 When exporting results to a file for the first time, the file types in the save file dialog were set up 

correctly. For each next time you exported results, the file types would be added to the already 

existing file types, which would make the file types appear twice in the list. 

Version 4.4.12 – Released 01/17/2012 
New features 

 Updated the communication plugin for the CC100. This new plugin performs much better when large 

amounts of votes are received in a short period of time. 

Minor changes 

 The option introduced in the previous version to determine how many bars to show in the chart had 

the side effect that after starting a session, all charts would show 0% for all answers, if the question 

had not been voted yet. In this version, that side effect has been removed. The charts will stay empty 

as long as no votes are available for that question. 

Bug fixes 

 When comparing or crossing a question, the question list dialog box would show the questions with 

their slide number as if it were their question number. 

 When comparing questions a question might show up empty even though it has been voted. Whether 

a question showed up empty depended on whether a certain keypad had voted or not. 

 Under some circumstances the Lite Base Station would not initialize when clicking the Initialize but-

ton. Clicking again would then initialize the Base Station without any problems. 

 When using an RF-I Base Station, closing the voting would make the Base Station go offline. 

 On some computer systems an RF-I or RF-II Base Station could not be initialized when connected to 

a real serial port. It could only be initialized when using a USB-to-serial converter cable. 

 When pressing  +  +  too many times, an Access Violation would occur. 

 Printing a script to JPGs while crossing all slides would not cross the slides and give an Index Out of 

Bounds (-1) message when a slide without a question was encountered. 
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Version 4.4.11 – Released 12/16/2011 
New features 

 The communication wizard was updated to support more COM-ports. It can now show a maximum 

of 16 ports, with any port between COM1 and COM64. 

 The communication wizard now differentiates between RF-II channels and Lite channels. This is be-

cause even though the wizard tells you to select different channels for each Base Station, you can 

still use the same channel for an RF-II Base Station and for a Lite Base Station. 

 Updated the communication plugins for the Lite Base Station and the RF-II Base Station. These new 

plugins perform much better when large amounts of votes are received in a short period of time. 

There is also a separate plugin for the RF-I Base Station. 

 (IVS-Professional only) Added a new option in the Results menu called Multiple-choice Distribution. 

For a question that could be voted on multiple times, this "crossing" shows how the multiple choices 

are distributed amongst the audience. You can, for example, see how many people voted 1, 2, 3, 4, 

how many people voted 1, 3, 8, etc. The results can also be split in different references, like a normal 

crossing. Note that at this moment, the order of the votes is not taken into account. This means that 

if someone voted 1, 3, 8, and another one voted 8, 1, 3, and another one 1, 8, 3, this will all be the 

same. 

 The results in a chart can now automatically be compared, crossed or distributed. In the properties 

of the chart, set the desired question in the Cross & Compare tab. Note that you can select either a 

question to compare with, to cross with or to distribute. You cannot have all three. Also note that 

this setting is linked to the question number, and not the question itself. This means that if you add 

or remove questions, this question number is not automatically updated to reflect the new question 

number. 

 If you have multiple charts on one slide, crossing, comparing or distributing will affect all charts. 

There is now an option to select a single chart, so that you can cross, compare or distribute only that 

single chart. Use the keys  +  +  to select the first chart,  +  +  to select the second 

chart, etc. Use  +  +  to select all charts. Note that the first chart is the one that was first 

placed on the slide (the one in the background). Also note that this option allows you to select a 

single chart out of a maximum of nine charts. 

 The properties of the chart have two new options to determine how many bars you want to show in 

the chart. For example, if you have 20 answers, you can set the first displayed bar to 1 and the 

maximum number of bars to 5, to only display the first five answers. If you then set the first displayed 

bar to 6 and leave the maximum number of bars to 5, you get bars 6 through 10. You can also use 

the new key combinations  +  +  to move to the next set of bars, and  +  +  to move to 

the previous set of bars. Note that the  +  +  key combination is not limited. If you press 

 +  +  20 times, you also have to press  +  +  20 times to get to the first set. Also note 

that some display drivers use the  +  +  combination globally to flip the screen upside down 

and  +  +  to flip it back to normal. If this happens, please disable the key combination in your 

display driver options. 
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 Added an option to the properties of the question to have the answers ordered from high to low. 

This only applies to the order of the bars in the result chart. Normally, answer 1 is at the top and 

answer 9 at the bottom. If you enable the option to have the answers ordered from high to low, 

number 9 will be at the top and number 1 at the bottom. Please note that you have to make sure 

that the actual ordering of the answer texts matches the order of the result chart. This is not done 

automatically. Also note that because of this option, the ‘Display answers next in rank’ option has 

also changed. In previous releases, this option would rank the answers from high to low. It will now 

rank from low to high. To get the same behavior as in previous versions, also use the option ‘Answers 

from high to low’. For older scripts, the ‘Answers from high to low’ option is automatically enabled 

when the ‘Display answers next in rank’ option is also enabled. For newer scripts, you have to do 

this yourself. 

Minor changes 

 After initializing the keypads without actually having initialized anything, you would still be asked 

to save the list or test the keypads. You will now only be asked to save or test if at least one keypad 

has been initialized. 

 The field of type Result can now also display the supermajority of voters and participants (in this 

case two thirds of the total votes), the simple and supermajority of voters and participants rounded 

upwards (this equals half of the total plus one, rounded upwards) and the total result of non-voters. 

 The field of type Network Status can now also display the total number of valid and invalid votes 

and the simple majority of the number of valid votes. 

 Updated the drivers for the Base Station to version 2.8.14.0. These drivers are signed with a VeriSign 

certificate and a Microsoft Cross-Certificate, so that these drivers can also be used on the 64-bit 

versions of Windows. Also updated the Card Reader drivers to version 1.2.6.5. These drivers are 

WHQL certified. 

 (IVS-Lite Link only) Added two checkmarks in front of the ID and Name field. When either of them is 

checked, the cursor will move to that field after programming a keypad. If none of them are checked, 

the cursor will move to the Name field if it contains text, or move to the ID field otherwise. 

 Updated the bitmapped status LEDs in the status bar and the Communication Wizard to one drawn 

using GDI+. 

 (Windows Vista and higher only) The application sets the Windows UI language to the current appli-

cation language. This means that some basic Windows UI elements appear in the application lan-

guage rather than the current Windows language. When you have installed any language packs 

(Windows Ultimate version only) in the application language, all Windows UI elements appear in the 

application language, rather than the current Windows language. 

 (Windows Vista and higher only) Updated the application manifest to include the DPIAware property. 

This property indicates that the application itself takes care of scaling the application windows at 

higher DPI levels. Without this property Windows 7 would scale the application windows, which 

would make it look like a scaled bitmap image. 
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 Updated the Communication menu. The Initialize Keypads submenu was integrated in the Commu-

nication menu. The Restore Communication and Save List options were renamed. The ‘Initialize key-

pads from list’ option can no longer be used for a Lite Base Station, because this makes no sense. 

Use the ‘Initialize all keypads’ option instead. 

 A new warning message is displayed when you load a list of initialized keypads while all connected 

Base Stations already contain keypads. The warning will not be displayed if one or more Base Sta-

tions don’t have any keypads. 

 The question if you want to load the last used keypad list will now only be asked if you use Lite Base 

Stations and no longer when you are using RF-II Base Stations. 

 Fixed several typos and wrong translations in the various warning messages. 

Bug fixes 

 When a field of type Network Status was put on the background slide, it was not updated properly. 

 When a field of type Network Status was put on the foreground slide, it was under some circum-

stances not updated properly. 

 On computers with a higher DPI setting (higher than 96 dpi) the question and answer number and 

the text of the timebar were displayed in a bigger font size than the rest of the text. This has been 

corrected, but is still the case for texts in the chart. 

 In the properties of the result chart, on the cross and compare tab, the settings for comparing were 

obscured by the settings for font size adjustment, on computers running with a higher DPI setting. 

 When voting a group question, the group name of people that did not vote for a specific group was 

reset to an empty group instead of leaving that group name to the original name. 

Version 4.4.10 – Rereleased 05/23/2011 
Bug fixes 

 On Windows 7 computers that had a wrong version of wdrvr.dll, reading the keylock would first try 

the USB and if not found, would also try LPT. Trying LPT would hang the dll, in effect hanging the 

entire application. This rerelease installs the correct version of wdrvr.dll, always overwriting the ver-

sion already installed. It also has more checks for wrong values in the registry, and only reads the 

keylock when all values are correct. It also changes a value in the registry so that the wdrvr.dll will 

no longer try the LPT anymore (although this version shouldn’t even be able to try the LPT anymore). 

Version 4.4.10 – Rereleased 04/22/2011 
Bug fixes 

 This version supports a new version of the proxy.xml, as well as being compatible with the standard 

proxy.xml. Unfortunately, the standard version was looking for questions nodes instead of question 

nodes. This would in effect make it incompatible with the standard version and wouldn’t display 

proxy results anymore. This was changed back in this rerelease. 
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Version 4.4.10 – Rereleased 04/07/2011 
Bug fixes 

 In the score field the total voting time was displayed with five decimal digits. This was for testing 

purposes only and shouldn’t have ended up in the release version. This was reverted back to two 

decimal digits. 

Version 4.4.10 – Released 03/09/2011 
New features 

 The IVS-Lite Keypad Information tool can be used to check the battery status of the Lite keypads. 

 Added the option to vertically align the text within the text box. The vertical alignment can be set 

up in the text editor, but it is only visible on the slide itself. 

Minor changes 

 The paragraph numbering option has been expanded with several new numbering options. They can 

be chosen from the drop down menu of the paragraph numbering button in the text editor. 

 Added the ‘Paste without formatting’ option to the popup menu of the text editor. This option pastes 

any text from the clipboard in just plain text, removing any formatting options, so that the formatting 

of the original text is retained. The new paste option can also be accessed through the  +  +  

shortcut. 

 The option ‘Absolute/Percentages’ from the ‘Results’ menu does no longer simply change between 

absolute values and percentages. It now changes between absolute values if the original setting is 

something else, or percentages if the original setting is absolute values, and the original setting. For 

example, if the original setting is ‘Percentage of total’, you now change between absolute values 

and percentage of total. 

 When a question that is set to display the results as ‘Percentage of first vote’ is crossed, the percent-

ages are now based on the total number of first votes of the crossing instead of the total number of 

first votes of the entire population. 

 The temporary license now shows how much time there is left for the license. 

 The temporary license has been extended from a maximum of five days to a maximum of 127 years. 

 The option to use a wireless presenter is automatically disabled when the software is closed. 

 The option ‘Cross/Compare to 100%’ now also works when the results are displayed as ‘percentage 

of first vote’. 

 On Windows Vista and higher, the open and save dialog now support a favorite link. Also the Browse 

for Folder dialog has been replaced by an Open Folder dialog, because the Browse for Folder dialog 

does not seem to support network locations on Windows 7 anymore. 

 Support for a new Proxy.xml version has been added. This version is simpler and can easily be main-

tained by Microsoft Excel. To use this new version, the document element tag must have a version 

attribute with a value of “2.0”. Below the document element tag are a single set of Proxy tags with 

a question, answer and value attribute. 
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 (Windows 7 only) Added support for the taskbar jump list. 

 Added a print plugin to print the slides to PNG images. 

 The field of type ‘Result’ now has two extra options to display the simple majority of the number of 

votes and the simple majority of the number of participants. 

 The field of type ‘Result’ can display the results of an answer in absolute values, percentages based 

on the number of votes and percentages based on the number of participants. The last two are the 

same for questions that can be voted on only once. 

 In the properties of a question you can now also set the minimum times to votes. Anyone who votes 

less than this minimum amount will have all of his votes rejected. 

 The field of type ‘Network status’ has three extra options to display the number of valid votes (for 

people who have voted at least the minimum amount of votes), the number of invalid votes (for 

people who have not yet reached the minimum amount of votes) and the simple majority of the valid 

votes. 

 Moved the splash screen on startup slightly upwards, so that it won’t entirely cover any message 

box that might also appear during startup. On Windows Vista and higher, under some circumstances, 

the message box could appear entirely covered by the splash screen. The application would seem to 

hang, because you were supposed to click on the totally invisible message box. 

 Renamed ‘Quorum’ to ‘Simple majority’ because the value displayed is in fact the simple majority, 

which is not necessarily the same as a quorum. 

Bug fixes 

 The option ‘Percentage of first vote’ did not work correctly for questions that were crossed several 

times. 

 The median value would often be 0.5 points too high. 

 When inserting a new field, the ‘Display’, ‘From question’ and ‘to question’ were not filled in cor-

rectly. 

 The Base Station Locator failed to link Base Stations to a COM port when the SERIALCOMM key was 

missing from the registry. This could happen on systems not having any real or virtual serial ports. A 

work-around is to create this key if it does not exist. 

 Opening two different scripts, starting a session in both scripts and then closing one session could 

make the other session inaccessible.  

  +  to split a crossed question did not actually split the question when invoked from the presen-

tation screen when the presentation screen was displayed on the same monitor as the edit screen. 

 On an interactive slide with a very large background image an Access Violation could occur when 

the slide was very frequently updated due to a lot of incoming votes. 

 On an interactive slide there was a memory leak whenever the result chart was updated. 
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Version 4.4.9 – Released 12/15/2009 
Minor changes 

 Improved the window handling when opening an existing script or creating a new one. You won’t 

see the window of the script get maximized any more. 

 Updated the drivers for the Base Station to version 2.6.0.0. These drivers are signed with a VeriSign 

certificate and a Microsoft Cross-Certificate, so that these drivers can also be used on the 64-bit 

versions of Windows. Also updated the Card Reader drivers to version 1.2.1.2. These drivers are 

WHQL certified. 

 The installation script for this version is created using Microsoft’s WiX toolset instead of InstallShield 

express. This toolset requires an XML file describing the installation requirements, which is much 

easier to maintain. 

 The drivers for the Base Station and the Card Reader are not only pre-installed, but are also installed 

for already connected devices and for phantom devices. This means that when a Base Station is 

connected during the installation of the software, its drivers are automatically updated to the latest 

version. If a Base Station is not connected, but the drivers were already installed, it will automatically 

update its drivers once it’s connected. 

Bug fixes 

 When the option ‘Display mean’ or ‘Display deviation’ was enabled, and the option ‘last answer does 

not belong to total’ was enabled, you would get a ‘Range check error’ if there were no results in 

your script. If there were results, you wouldn’t get this error, however, after saving and reopening 

your script, it would still give this error and refuse to open your script. 

 When the option ‘Normalize to 100%’ was used, the mean value and the deviation could differ from 

the real values. 

 On Windows Vista or Windows 7, the application could hang when starting up. On Windows Vista 

64-bit or Windows 7 64-bit, the application would only work the first time after a reboot. Any sub-

sequent attempt to start the application would result in the application hanging at startup. This was 

caused by the keylock driver failing to read the keylock and hanging the entire application. An up-

dated keylock driver prevents this, however, the new driver no longer supports the parallel keylock. 

 Opening the voting on a question that had already been voted on would give an error message when 

the corresponding result file could not be opened. This would leave the status of the Base Station to 

‘Opening’ which could never be changed anymore. Closing the application would solve the problem. 

There is now an extra ‘File Error’ status indicating something is wrong with the result files. This error 

can only appear when trying to open the voting. The voting will not be opened until the problems 

with the result file are solved. 

 The default score, that can be set in the properties of the question, was not taken into account 

anymore. 
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Version 4.4.8 – Released 09/23/2009 
Minor changes 

 Added an option to the Score field to only display the score, name, etc. when the total score is 

positive, i.e. someone has more than zero points. 

Bug fixes 

 (Lite Base Station only) The Lite Base Station not only sends legal votes, but also sends ‘bogus’ 

messages. These are filtered out by the communication plugin. However, the plugin would still send 

a message to the IVS software to indicate that a vote was received, which would lead to unnecessary 

screen updates. 

 Whenever a vote was received, the entire screen was updated, even though it was already clear that 

nothing on the screen had changed. This would lead to unnecessary slow screen updates. 

 When the timebar was set to Close the voting after so many seconds and Go to the next slide after 

so many seconds, it would immediately start counting down to go to the next slide instead of waiting 

for voting to be opened. 

 When the aspect ratio was set to 16:9, an image used as the background for the slide would still be 

in a 4:3 ratio, which would make it look compressed. 

 (IVS-Card Link only) After programming a set of cards, you could only check the card if it was still in 

the card reader. Once removed and reinserted into the card reader, it could not be checked any more. 

Version 4.4.7 – Released 07/21/2009 
New features 

 Added support for a license stored in the Base Station. Multiple licenses can be stored in multiple 

Base Stations and they will all be added up. Note that when a USB license is available, this one will 

take precedence and the licenses in the Base Stations will be ignored. 

 Added support for a temporary license being less temporary. A temporary license can now last for 

as long as 128 hours (5 days and 8 hours). The actual duration can be determined by the license 

code. 

 Added more preferences. It is now possible to set up an update checking interval. It is also possible 

to set up a Remote Presenter. This option allows for another shortcut key to be assigned to the 

‘Change voting’ option in the ‘Voting’ menu, so that the Presenter can be used to open/close the 

voting. 

Minor changes 

 (IVS-Card Link only) Improved the card reader checking mechanism. This prevents the application 

from consuming about 70% processor time. This has been reduced to about 0% processor time. 

 The Preferences dialog now checks each time to see if the monitor count has changed and updates 

the combobox accordingly. This prevents you from having to restart the application after setting up 

an extended desktop. 
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 The Score field now also calculates the score for a question that can be voted on more than once 

instead of only taking the first answer given. 

 The option ‘Cross/Compare to 100%’ no longer prevents you from selecting anything else but per-

centages. You can leave this option enabled and still switch to absolute values. In that case the 

option will not be used, because it doesn’t make sense for absolute values. 

 Locking the presentation screen no longer reloads all objects on the slide. This means you can even 

lock the presentation screen while a timebar is running without the timebar starting over again. 

 Crossing, comparing, splitting or showing the correct answer also no longer reloads all objects, so 

that an empty timebar stays empty when showing the correct answer. 

 The keyboard shortcuts  +  through  +  to split a crossed question or to display the 1st, 2nd, 

etc. choice now also work from within the edit screen. 

 The option to set a primary and secondary bar color in the properties of a question has been removed. 

Instead, you can now set up a maximum of five (IVS-Basic, IVS-ID) or ten (IVS-Professional) bar colors 

in the properties of the result on the template slide. This means that you no longer have to set up a 

single color for each question you ever want to compare with. 

 The formatting of the question and answer number is no longer based on the formatting of the first 

character of the text, but instead on the entire formatting of the text. If this formatting is ambiguous, 

the formatting of the last character of the text (usually the CR/LF) is taken. The number is never 

underlined, regardless of whether you underline the entire text. The formatting and underlining is 

now according to how Microsoft Word formats and underlines paragraph numbers. 

 Added a new action to the Advanced properties of a text object. This allows you to switch to the 

Risk Analysis application by clicking on a text object. 

 The sound effects of the timebar can now also be set in the template. 

 When a Base Station is not responding or was removed from the system, the notification window 

now includes the COM port of the Base Station that was not responding or has been removed from 

the system. 

 (Keylock Update Utility only) Updated the UI so that it immediately shows for which software pack-

age the keylock can be used and up to which version. This is instead of having to first select the 

software package to be able to see the version. 

Bug fixes 

 Unable to load a list of keypads that were initialized on channel 0. 

 When comparing questions that had an empty legend text, the legend in the chart would display 

‘Series0’, ‘Series1’, etc. This has been changed to display ‘Question #’, where # is the number of the 

question. 

 A question or answer without any text in it would not follow the text formatting as set up in the 

template slide. 

 Importing a text script with a correct answer would not set the score to 1. 

 (French version only) The text editor for entering question and answer texts was missing the images 

for the Bold (Gras) and Underline (Souligne) buttons. 
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 (Arabic version only) The Yes/No/Don’t Know answer option was conflicting with the reading order 

option. Setting one would also set the other. 

 The new status bar introduced in version 4.4.6 was being repainted 10 times per second, even though 

no changes in the status had taken place. Depending on your processor speed, this would drive CPU 

usage from anywhere between 10% to even as high as 90%. Repainting now only takes place after 

a status change, which drops the CPU usage back to 0%. 

 Connecting both a Lite Base Station and an RF-II Base Station in that order would cause the software 

to go to Stand By as soon as the Lite Base Station was stand by, even though the RF-II Base Station 

could still be closing the voting. It was then possible to open the voting again, which would only 

open the voting on the Lite Base Station. Closing the voting would lead to an “Out of Memory” 

error. The software now waits until all Base Stations report Stand By. 

 Using the option ‘Percentage relative to first vote’ would lead to ridiculously high percentages when 

the ‘Vote weight for voting’ option was also used. This was caused by the fact that the voting weight 

was not used when counting the number of first votes. 

Version 4.4.6 – Rereleased 02/26/2009 
Minor changes 

 When multiple Lite Base Stations are connected, the ones that are not currently initializing keypads 

will be set in mute mode. This is to prevent that keypads cannot be initialized on the current Base 

Station because they will respond to one of the other Base Stations that is on the same channel as 

the keypad being initialized. 

Version 4.4.6 – Released 02/10/2009 
Minor changes 

 The status bar was replaced by a new status bar component. This will hopefully get rid of the status 

bar sometimes showing menu options in its panels. 

 The way options are saved in the registry was changed. Changed options are now immediately saved 

instead of upon exiting the application. 

 The Communication Wizard now remembers which channel was used for a Lite Base Station. Previ-

ously it would switch to channel 0 if a channel higher than 10 was used and the Base Station was 

not connected. 

Bug fixes 

 When the options ‘Group question’ was checked, the option ‘Reference question’ was disabled. This 

is not necessary, a group question can also be used as a reference question. 

 (IVS-ID only) The option to use the voting weight was disabled by default and could not be enabled. 

 (Lite Base Station only) While initializing keypads, a keypad could sometimes fail to initialize even 

though the software said it initialized correctly. This behavior has been changed, but this also means 

that a keypad that had already been initialized cannot show anymore that it cannot be initialized 
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again. A keypad that is already initialized will still show a green led when a button is pressed for a 

second time. Of course the software will not count it again. 

 When opening the voting, the field to display the total results would display ‘1’ instead of ‘0’. This 

happened only when the result was set to be displayed in percentages (which shouldn’t have been 

possible in the first place). 

 When opening scripts saved with earlier versions, the bars in the result diagram that had a gradient 

would run from black to color instead of from color to white. 

 When copying a question, the legend text of the question was not copied. 

 After printing a script, the status bar would display that the last slide printed was shown, even if the 

first one was actually shown. After clicking once on the slide, the correct slide number was shown. 

Version 4.4.5 – Rereleased 01/14/2009 
Bug fixes 

 (Lite Base Station only) The work-around for the Lite Base Station that was introduced in the previous 

rerelease only worked during an open voting. But it also had to work during the initialization of the 

keypads. This was fixed in this rerelease. 

Version 4.4.5 – Rereleased 12/15/2008 
Bug fixes 

 (Lite Base Station only) The Lite Base Station could sometimes forget to send its data. A work-around 

was created which sends a message to the Base Station every second, so that the Base Station must 

answer and must send data that it already buffered but did not send yet. This work-around is only 

performed for Base Stations with a version less than 1.01. For newer Base Stations the problem has 

been resolved. 

Version 4.4.5 – Released 11/24/2008 
New features 

 Importing from and exporting to a text file now also supports text objects. To include a text object 

in the text file, start the text with an ampersand. 

 Added an automatic update checked. Upon application startup, a check is made to ensure that the 

latest version of the software is used. Also added an option in the Help menu to do a manual check. 

 (IVS-Professional only) Added a new property ‘Group question’ to the question properties. This op-

tion is only available for identified voting, and can be used to let the participant choose to which 

group he belongs. Each answer of this group question defines a group name. The group name is 

taken from the legend text of the answer, so you can make long answer texts and short group names. 

Voting this question will completely overwrite the settings previously stored with the IVS-Card Link 

application. If a participant does not vote, he will be put in an empty group. The previous group, set 

either with IVS-Card Link or with a previous group question, will not be kept. 
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 Added a new color option to the Background properties of a field of type Score. When the Display 

setting is set to ‘Name of group’, you can choose the background color ‘Group color’. This will set 

the background color of the field to the color of the group. The group color can be set with a group 

question. Each answer is a group name, and each answer color is a group color. 

 A question now has a legend property. This legend text will be used when comparing questions. 

 A question also has a bar color property and a secondary bar color property. The primary color will 

be used when comparing this question with a different question from the same script. The secondary 

color will be used when comparing this question with itself but with results from a different session. 

 When using a bar chart with a gradient bar, the start color and a middle color can now be specified 

and the direction of the gradient can be specified. 

 A new field type ‘Network status’ has been added, which allows you to display the number of active 

keypads, or the number of votes received, etc. 

Minor changes 

 The result diagram has several new bar types for displaying a bar chart. 

 Pasting an image from the clipboard now uses a random filename instead of a sequentially numbered 

filename. This is to prevent that copying slides from one script to the other will overwrite an image 

with the same filename. 

 Added a drop shadow and an exponential slide (instead of a linear slide) to the splash screen. 

 Moved the separate Font dialog for the Result Diagram and the Timebar to the properties dialog. 

Bug fixes 

 The Lite Base Station could go offline sometimes. When closing the voting took longer than two 

seconds, the software would go to stand-by even though the voting was still closing. Immediately 

opening the voting again would make the software go to offline. 

 If a Base Station was connected and set up to automatically initialize at startup, it would ask to load 

a keypad list. However, if a list was never saved before, loading the list would give an error message. 

 If the software was set up to not initialize any Base Stations at startup, it would still ask to load the 

last used keypad list. 

 Initializing a Lite Base Station could take a considerable amount of time, which was unnecessary. 

 Clicking on a link that had to switch to the next slide while the voting was still being closed could 

lead to unpredictable results. 

 Editing the text in the template slide is no longer possible. Because the entire text has to be selected, 

entering a single letter would already overwrite the entire text. 

 When importing a session, after deselecting any item in the list, the OK button was not disabled. 

Clicking the OK button would lead to an Access Violation. 

 When editing the font of a field, the font combobox would state that the font name was System even 

though the actual font name was Arial. 

 Using Lite keypads on an identified question, a corrected vote could be corrected again. This could 

lead to a negative vote counter and an Access Violation. 
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Version 4.4.4 – Released 09/29/2008 
New features 

 Added support for identified voting with the IVS Lite Base Station and keypads. Use the IVS-Lite Link 

tool to create a list of participants. Each participant gets an identified Lite keypad. 

Bug fixes 

 When using both user-specific and machine-specific answer templates, the wrong template would 

be inserted when choosing one from the Insert menu. 

 Saving a script as a text script would put all questions and answers on one slide. 

 Closing the voting on a different slide did not return to the slide where the voting was opened. 

 The software might refuse to start when another application (e.g. the Base Station Locator) was 

open. 

Version 4.4.3 – Released 06/03/2008 
New features 

 Support for the new IVS Lite Base Station and keypads. 

Minor changes 

 In the properties of the chart, an option was added to remove the thin black frame from each of the 

bars in a bar chart. 

 In the properties of the chart, the options to have the value displayed on top of the bar or just below 

the bar were replaced with an option to indicate the distance between the value and the bar. This 

allows for greater flexibility in displaying the values. 

 Updated various icons used in the applications. 

 (IVS-Professional only) The Participant field to show the names of participants that voted for a par-

ticular answer now has the option to start with a certain name and only display a certain amount of 

names. This allows you to display the names in columns. 

Bug fixes 

 When moving multiple objects around, they were placed at the new location one by one instead of 

all together at the same time. 

 When setting the text alignment of a question or answer to something else than left alignment, any 

new question or answer would still left align. 

 If a text had only one word underlined, editing that text would display the entire text as underlined. 

 When opening a file from the Most Recently Used file list, it was automatically removed from this 

list when the file could not be found. However, the File menu was not updated. 

 When opening the voting on a question with only one answer, the vote settings were taken from the 

previous question. For example, if the previous question had five answers, you could vote from 1 to 

5, even though the current question only had one answer. 
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 (Arabic version only) The popup menus were still in the left-to-right reading order. This has been 

changed to reflect the correct reading order. 

 On some Windows XP computers and Windows Vista computers with disabled Aero interface, the 

screen could flicker when opening a script and after editing texts. 

 An Access Violation could occur when going to another slide using the  +  +  in the presen-

tation screen while the voting was still closing. Going to another slide has been blocked while the 

voting is being closed. 

 Opening and converting an older script could lead to an extremely large script, which would make 

the script unnecessarily slow. 

 When using a CC100, the program would state that the voting was opened before it got a confirma-

tion by the CC100. Immediately closing the voting could lead to the CC100 not responding anymore, 

because it stayed in an opened state while the software was already in a closed state. 

 The Base Station Locator could sometimes link two Base Stations to the same COM port. 

 Images used as the background for a text object or a field object were not saved into the Images 

folder of the script. 

Version 4.4.2 – Released 03/21/2008 
New features 

 Support for the new IVS Lite Base Station and keypads, although the communication dll is not yet 

installed. 

Minor changes 

 Improved speed when displaying a slide containing lots of text. 

 When opening a file from the Most Recently Used file list, it is automatically removed from this list 

when the file cannot be found. 

Bug fixes 

 The check for an already running instance did not work anymore. This resulted in a new instance 

being started each time a script was opened from the explorer. It also caused the link from Power-

Point to IVS to not function anymore, because it didn’t go back to IVS but instead started a new 

instance of IVS. 

 Fixed two memory leaks in the handling of fields. 

 Moving an object in the edit screen did not immediately move the same object in the presentation 

screen. 

 Printing a script layout did not take into account the voting weight. 

 After aligning the answers to the bars in the chart, the formatting of the last part of some answers 

could change back to the formatting as set up in the template, while the first part of the answer kept 

the formatting as set up for that answer. 
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Version 4.4.1 – Released 02/19/2008 
New features 

 Updated the Multimedia object to use DirectShow instead of Video for Windows. It can now play 

any file that has a DirectShow filter installed. 

 The Multimedia object now displays an error message in the top left corner if the DirectShow system 

could not be initialized, or the file could not be found or rendered. 

 It is now possible to place more than one Multimedia object on a slide. They can all start playing at 

the same time or one after the other. A new start action was introduced that allows the object to 

start playing after the previous one has finished playing. 

 Updated the Timebar object to use DirectShow to play the sounds. The timebar can now play any file 

that has a DirectShow filter installed instead of only wave sounds. It can even play video files, but 

will of course only play the sound portion of it. 

 Updated the way rtf texts are displayed. It now uses the ITextServices interface rather than a hidden 

RichEdit window. This also allows for more font and paragraph settings to be set up in the template. 

 A new chart type ‘4-quadrant chart’ was added. This chart type takes two questions with the exact 

same answers. It calculates the ranking of each of these questions and then puts the results of the 

first question on the X-axis and the results of the second question on the Y-axis. 

 A new field type ‘Cumulatives’ was added. This field can display the total result per answer of a 

question or a group of questions. It can also display various statistical values of a question or a group 

of questions. 

 The Base Station Locator tool now lets you choose from which serial port to begin with linking. This 

allows for serial Base Stations to be used on COM1 and COM2 and Network Base Stations on COM3 

and further. 

 The option ‘Align answers’ now makes the answers sticky: they stick to the bars in the bar chart. If 

the chart is moved, the answers move along with it. Note that this is a global option which will make 

the answers sticky throughout the entire script. Only the answers on the current slide are actually 

moved to their new position. All other answers stay on their original position, but will snap to the 

bars as soon as the slide is shown. 

Minor changes 

 When changing an image object or a multimedia object, the new image or multimedia will fit within 

the bounding rectangle of the previous image or multimedia, instead of using the full size of the new 

image or multimedia. 

 Saving a list of keypads will also store the channel number of the Base Station. When loading this 

list again, it will try to match a Base Station based on the channel number rather than the port 

number. Note that it will not try both: if a channel number is present, the channel numbers must 

match; if a channel is not present, the port numbers must match. 

 When the presentation screen is started on a secondary monitor, the cross, compare and go to slide 

function will no longer bring up the task bar to wait for input, but will instead bring up the normal 

dialogs on the primary monitor. 
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 The option to rotate the legend text on the axis with 90° was changed to rotate it only 45°. This 

makes the labels more readable. 

 Updated the Keylock Test Utility and the Base Station Locator so that, under Windows Vista, they no 

longer need to be started with administrator rights. Only when administrative rights are required for 

a specific function, you will be asked to give permission. 

 A new option ‘Adjust bar width to’ has been added to the Cross & Compare tab of the result diagram 

properties. This option allows you to set up a different bar width that is used during a crossing or 

comparison. 

 The field type ‘Score’ can now also display the minimum, maximum and average score of a certain 

group. 

 Increased the total time a voting can stay open using the voting time from 27 minutes to 49 days. 

 A new option ‘Percentage based on first vote’ was added to the Chart properties. This can be used 

when voting more than once and will display the results in percentages, based on the total number 

of people that voted at least once. This could give you results of more than 100%. 

 When using a 2D chart, it is now possible to hide the axes but still have the values on the axes. 

 When reapplying the template, you can now indicate whether or not to put the objects back to their 

original location. 

 The screen aspect ratio is saved with the current script. If you open a script which was made with a 

different AR, the current AR will change to match that of the script. 

 The default resolution for the slide has changed for ARs other than 4:3. In previous versions, the 

width of the slide was always 1024 and the height was automatically adapted depending on the 

selected AR. Starting from this version the width and height of the slide are variable, depending on 

the selected AR: 4:3 = 1024x768; 5:3 = 1280x768; 5:4 = 1280x1024; 16:9 = 1280x720; 16:10 = 

1280x800; 25:16 = 1600x1024; 85:48 = 1360x768. 

 If a field of type ‘Score’ is inserted and none of the questions use identified voting, an error message 

will be displayed in the field, even if no session has been started yet. 

Bug fixes 

 Field objects that were on the background slide were not updated when the voting was closed. Going 

to the next slide and then back would still update them. 

 When initializing keypads with more than one Base Station, you were not asked to save the list or 

test the network. 

 When using a large font in the result diagram, the values on top of the bars might get cut off because 

they fell outside the diagram rectangle. 

 Copying multiple answers at once would mix up the legend text of the answers. 

 Aligning objects that fell outside the borders of the slide would align the object on the border of the 

slide instead of aligning them to each other. 

 (IVS-ID and IVS-Professional only) The IVS-Card Link Utility might hang upon startup when no readers 

were connected. 

 Cutting and pasting the last slide containing a question to a different location would lose the results 

of that question. 
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Version 4.4 – Released 06/12/2007 
New features 

 (IVS-Professional only) Answers can now be grouped together in different answer groups. When 

voting more than once, only answers belonging to the same group can be selected. As soon as an 

answer from a different answer group is selected, all the other answers will automatically be cleared. 

 (IVS-Professional only) A text object can have an action associated. When you click on this object, 

the associated action will be performed. 

 Added support for anti-aliasing for BMP, JPG and PNG images. (Note that this requires GDI+ to be 

installed on the system.) 

 Added support for transparent and semi-transparent PNG images. (Note that this requires GDI+ to 

be installed on the system.) 
Note: GDI+ can be downloaded separately from the Microsoft website. It is included 
in Windows XP and above. 

 Added support for transparent and animated GIF images. (Note that for the moment only one GIF 

image per slide is allowed.) 

 When importing results, the statusbar shows the ‘I:’, ‘A:’, ‘V:’, etc. that were recorded at the moment 

the voting for this question was opened. This is only displayed when there is no active Base Station 

connected. 

Minor changes 

 Improved crossing of results. There is no real limit on the number of questions you can cross with, 

but for the moment it has been limited to 1 question for IVS-Basic, 2 questions for IVS-ID and 5 

questions for IVS-Professional. The crossing uses the colors of the question you are crossing with. 

When splitting a crossed question, the title of the chart shows all the steps you took to get to this 

split. Use  +  to return to the original question, or  +  +  to go one step back. 

 Improved comparing of results. There is no real limit on the number of questions you can compare, 

but for the moment is has been limited to 5 questions for IVS-Basic and IVS-ID, and 10 questions for 

IVS-Professional. The legend now shows the text of each question, instead of just ‘Question 1’, 

‘Question 2’, etc. Use  +  to return to the original question, or  +  +  to remove the last 

question. 

 Improved left-to-right and right-to-left support. This can now be set per paragraph instead of per the 

entire text. Note that these settings are only available when a right-to-left language is installed on 

the system. 

 Improved license handling. If the license was removed after initializing more than 25 keypads, you 

could vote with all initialized keypads, but only the votes of the first 25 keypads would be used in 

calculating the totals. This has been changed so that one cannot start a session with more keypads 

initialized than the license allows. 

 The license is checked more often and at different locations. If you connect a license you don’t need 

to initialize the cluster, just to get your license working. The license is also checked when you open 

the about box or start a session. 
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 Added a ‘K:’ in the statusbar that indicates the number of keypads that have voted. This only differs 

from the ‘V:’ (number of votes received) if you allow voting more than once. For example, if one 

keypad voted three times, the ‘K:’ would be 1, and the ‘V:’ would be 3. 

 The ‘I:’, ‘A:’, ‘K:’, ‘V:’ and ‘W:’ in the statusbar can now be separately switched on and off. This allows 

you to switch off information that you don’t need. Just right-click on the statusbar and choose which 

items you want to see. 

 Updated calculation of mean and standard deviation. If the option ‘Last answer does not belong to 

total’ is checked, the mean and standard deviation will also not use the last answer in their calcula-

tion. 

 The field of type ‘Score’ now lets the user choose which relative score and which maximum score are 

displayed. One can now choose between the relative and maximum score based on the number of 

participants per group (that means all participants, whether they vote or not), or on the number of 

voters per group (that means all participants from a group that actually voted). 

 The ‘Communication > Initialize cluster’ menu option can now only be used to initialize the cluster. 

If you need to change settings, use ‘Communication > Settings’ instead. 

 Pausing the timebar and the multimedia object has been separated into two different commands. 

Use  to pause the timebar and  +  to pause the multimedia object. 

 Fixed several smaller issues between the different language versions of the software. 

 Improved calculation speed of the ‘Score’ field. Displaying a top-10 is now much faster. 

 Added keyboard shortcuts  +  +  and  +  + to the ‘Align answers’ options. 

 Added an extra ‘PRES’ indicator in the statusbar. This indicator is highlighted when a presentation 

has been started. 

 Added the option to lock the presentation screen when the presentation screen is shown on a differ-

ent monitor than the edit screen. When the presentation screen is locked, any changes made to the 

edit screen will not automatically propagate to the presentation screen. 

 Added an extra ‘LOCK’ indicator in the statusbar. This indicator is highlighted when the presentation 

screen has been locked. 

 The result diagram now has an option to display the chart from-right-to-left. This is only useful for 

the Arabic version so this option will only be enabled when the Arabic language group is installed in 

Windows. 

 When pasting or duplicating multiple objects at once, the newly pasted objects will all be selected. 

Previously, this was only done when only one object was duplicated or pasted. 

 Pressing the Alt key in the presentation screen will no longer open the menu in the editing screen. 

This could lead to a seemingly unresponsive system, especially when the presentation screen was on 

the same monitor as the editing screen. 

 Added Windows Vista support. Some file locations have changed to comply with the Windows Vista 

standard. An updated manifest is included in all applications to indicate whether the application 

requires elevation or not. Each executable and library is now digitally signed. The installation is now 

built with InstallShield Express 12 and is also digitally signed. 

 Dropped support for Windows 95, 98, Me and NT 4.0. Even Microsoft no longer supports these ver-

sions. Drivers included on the cd only support Windows 2000 and above. 
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Bug fixes 

 Setting a paragraph to be justified in the text editor did not (always) have effect in the text object. 

 (German version only) In the text editor, some characters with “umlaute” were replaced by other 

characters. 

 If a script could not be saved because the file was read-only, there was no warning message. Even 

the ‘modified’ indicator would disappear, suggesting that the file was successfully saved. There is 

now a warning message and the ‘modified’ indicator stays as long as the file could not be saved. 

 If the ‘Times to vote’ was set to 0, meaning that one could vote an unlimited number of times, the 

results would not be shown. 

 The question number and answer number did not take over the font style of the first line of text. 

 The question number and answer number would always be displayed on the left side, even if the 

first line was set to right-to-left reading. 

 If a ‘Score’ field was set to display the results of a certain group, it was not possible to display this 

group’s name. 

 A ‘Field’ object did not take over the font color of the template. 

 (IVS-Professional only) The advanced properties of a text object did not take over the settings in the 

template. 

 Some AVI files could not be loaded by the multimedia object. 

 When applying a template, or creating a new script from the File menu, a checkbox ‘Do not show 

this dialog again’ was shown, but had no effect. This checkbox has been removed. 

 (IVS-Professional only) When a field of type ‘Score’ was inserted and the option ‘Sort on’ was turned 

off, the next time you viewed the properties of this field, the option would appear to be turned on 

again. In fact, the option was turned off, but the checkbox was still checked. Clicking OK or Apply 

would actually turn the option on again. 

 After changing the number of an answer and then copying and pasting the answers to a new slide 

would put the answers in the wrong order. 

 When closing a script that was still used for the presentation, some unexpected errors could occur. 

Now when closing the script, the presentation will also be closed. 

 Fixed the Stop command of the multimedia object. A wrong command was sent to the driver, that 

caused some drivers (the midi sequencer for example) to fail with an Access Violation. 

 Fixed the Pause/Resume commands of the multimedia object. Some drivers do not support the Pause 

command but instead execute the Stop command. Trying to Resume playback then fails because the 

file has already stopped playing. Now, when a Resume command fails, a Stop and Play command 

will be sent, to continue playback from the beginning of the file. 

 Duplicating multiple slides in the slide sorting would result in only duplicating the last selected slide. 

 Removing a USB Base Station from the system by either disconnecting the USB cable or the power 

cable could result in Access Violations. A message box is now displayed instead, indicating that the 

Base Station was removed unexpectedly. 

 Reapplying a template would remove the score from an answer. 
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 If a Base Station, a CC100 and another Base Station were attached in this order, resetting the key-

pads would stop after the first Base Station and not continue with the second Base Station. 

 If two or more slide sorter views were open at the same time, right clicking in one of the windows 

would not give that window the focus, resulting in the action to be performed in the wrong window. 
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